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Περίληψη 

Το Εμβρυϊκό Αλκοολικό Σύνδρομο (Fetal Alcohol Syndrome, FAS) προκαλείται όταν 

γυναίκες κατά τη διάρκεια της εγκυμοσύνης καταναλώνουν αιθανόλη και σχετίζεται 

με δυσμορφίες, διανοητική καθυστέρηση, προβληματική συμπεριφορά και 

καρδιοπάθειες στο έμβρυο. Σκοπός της εργασίας είναι η μελέτη της επίδρασης της 

ηλικίας και της προγεννητικής έκθεσης στην αιθανόλη στον εγκέφαλο ενήλικων 

επίμυων Sprague Dawley 2 και 3,5 μηνών με έμφαση τον κυτταρικό θάνατο που 

προκαλείται. Η προγεννητική έκθεση στην αιθανόλη διήρκησε από την αρχή και σε 

όλη τη διάρκεια της κύησης μέχρι και 2 εβδομάδες μετά τη γέννηση, χρονικό 

διάστημα που αντιστοιχεί από το πρώτο μέχρι το τρίτο τρίμηνο της κύησης στον 

άνθρωπο. Πειραματικά πραγματοποιήθηκαν ιστοχημικές (χρώση Nissl) και 

ανοσοϊστοχημικές (ανοσοδραστικότητα NeuN)  χρώσεις σε στεφανιαίες τομές 

εγκεφάλου αλλά και ανοσοαποτύπωση κηλίδας για την εκτίμηση πρωτεϊνικών 

επιπέδων με τις περιοχές του προμεταιχμιακού φλοιού, του ραχιαίου (Κερκοφόρος 

& Κέλυφος) και κοιλιακού (Επικλινής πυρήνας) ραβδωτού σώματος, του κεντρικού 

πυρήνα της αμυγδαλής και του μεσολοβίου στο επίπεδο του ιπποκάμπου να 

αποτελούν τις υπό μελέτη περιοχές. Τα αποτελέσματα έδειξαν μείωση στην ένταση 

σήματος των σωματιδίων Nissl (δείκτης πρωτεϊνοσύνθεσης στα νευρικά κύτταρα) 

στα 3,5 μηνών ζώα ελέγχου σε σχέση με τα αντίστοιχα 2 μηνών στην περιοχή του 

πυρήνα και κελύφους του επικλινούς πυρήνα καθώς και στον κεντρικό πυρήνα της 

αμυγδαλής ενώ παρατηρήθηκε και μείωση στον συνολικό αριθμό και στον αριθμό 

μόνο των νευρικών κυττάρων στην περιοχή του ραχιαίου ραβδωτού σώματος 

υποδεικνύοντας την επίδραση της ηλικίας σε αυτές τις περιοχές. Η προγεννητική 

έκθεση στην αιθανόλη φάνηκε να προκαλεί μείωση στην ένταση των σωματιδίων 

Nissl στην περιοχή του ραχιαίου ραβδωτού σώματος στα ζώα 3,5 μηνών που 

εκτέθηκαν σε σχέση με τα αντίστοιχα ζώα ελέγχου ενώ παρόμοια μείωση φάνηκε 

και στην κεντρική αμυγδαλή στα ζώα 2 μηνών που εκτέθηκαν στην αιθανόλη σε 

σχέση με τα αντίστοιχα φυσιολογικά. Στην περιοχή του κελύφους του επικλινούς 

πυρήνα η προγεννητική έκθεση στην αιθανόλη προκάλεσε αύξηση στην ένταση των 

σωματιδίων Nissl στα ζώα 3,5 μηνών που εκτέθηκαν. Επίσης, η αιθανόλη προκάλεσε 
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μείωση στην έκφραση του δείκτη νευρικών κυττάρων NeuN στο ραχιαίο ραβδωτό 

σώμα στα ζώα 2 μηνών, όπως και μείωση στον συνολικό αριθμό και στον αριθμό 

μόνο των νευρικών κυττάρων στην περιοχή του ραχιαίου ραβδωτού σώματος στα 

ζώα 2 μηνών. Η περιοχή του μεσολοβίου στο επίπεδο του ιπποκάμπου δεν φάνηκε 

να επηρεάζεται από την αιθανόλη. Εν κατακλείδι, τα αποτελέσματα της εργασίας 

δείχνουν ότι η αύξηση της ηλικίας επηρεάζει τη δραστηριότητα και τον αριθμό των 

νευρικών κυττάρων στον εγκέφαλο επίμυων καθώς και ότι η προγεννητική έκθεση 

στην αιθανόλη προκαλεί κυτταρικό θάνατο στον εγκέφαλο αυτών. Στόχος ήταν η 

καλύτερη κατανόηση του Εμβρυικού Αλκοολικού Συνδρόμου με τη διενέργεια 

επιπλέον μελετών για την εξαγωγή περισσότερων συμπερασμάτων να καθίσταται 

απαραίτητη. 
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Abstract 

Fetal Alcohol Syndrome (FAS) is caused when women during pregnancy consume 

ethanol and is associated with malformations, mental retardation, problematic 

behavior and heart disease in the fetus. The purpose of the work is to study the 

effect of age and prenatal exposure to ethanol in the brain of adult Sprague Dawley 

rats of 2 and 3.5 months old with an emphasis on the cell death induced. Prenatal 

exposure to ethanol lasted from the beginning and throughout pregnancy up to 2 

weeks after birth, a period corresponding to the first to third trimester of pregnancy 

in humans. Experimentally, histochemical (Nissl staining) and immunohistochemical 

(NeuN immunoreactivity) stainings were performed on coronal brain sections as well 

as Dot blot to assess protein levels, with the areas of the prelimbic cortex, dorsal 

(Caudate Nucleus and Putamen) and ventral (Nucleus Accumbens) striatum, central 

nucleus of the amygdala and corpus callosum at the level of the hippocampus being 

the areas under study. The results showed a decrease in the signal intensity of Nissl 

bodies (a marker of protein synthesis in nerve cells) in the 3.5 month old control 

animals compared to the corresponding 2 month old ones in the area of the core 

and shell of the nucleus accumbens as well as in the central nucleus of the amygdala, 

while it was also observed a decrease in the total number and the number of only 

nerve cells in the dorsal striatum indicating the effect of age in these areas. Prenatal 

exposure to ethanol caused a decrease in Nissl bodies intensity in the dorsal striatum 

of 3.5 month old animals exposed relative to their control counterparts, while a 

similar reduction was seen in the central amygdala of 2 month old animals exposed 

to ethanol compared to their normal counterparts. In the shell region of the nucleus 

accumbens, prenatal ethanol exposure caused an increase in the intensity of Nissl 

bodies in 3.5 month old exposed animals. Also, ethanol caused a decrease in the 

expression of the neuronal marker NeuN in the dorsal striatum in the 2 month old 

animals, as well as a decrease in the total number and the number of only neurons in 

the dorsal striatum in the 2 month old animals. Corpus callosum at the level of the 

hippocampus did not appear to be affected by ethanol. Ιn conclusion, the results of 

the work show that increasing age affects the activity and number of nerve cells in 
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the brain of rats and that prenatal ethanol exposure causes cell death in their brain. 

The goal was a better understanding of Fetal Alcohol Syndrome with additional 

studies to draw more conclusions becoming necessary. 
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Εισαγωγή 

 

Εμβρυϊκό Αλκοολικό Σύνδρομο 

Το Εμβρυϊκό αλκοολικό σύνδρομο (Fetal Alcohol Syndrome, FAS) είναι η πιο 

επιβλαβής μορφή διαταραχών που οφείλονται σε προγεννητική έκθεση στην 

αιθανόλη (Fetal Alcohol Spectrum Disorders, FASD) και χαρακτηρίζεται από χρόνια 

κατανάλωση αιθανόλης κατά τη διάρκεια της εγκυμοσύνης και σχετίζεται με 

σημαντική τερατογόνο δράση στο έμβρυο [1]. Η τερατογόνος αυτή δράση προκαλεί 

καθυστέρηση στην ανάπτυξη του εμβρύου, χαρακτηριστικές δυσμορφίες στο 

πρόσωπο (εικόνα 1), δυσλειτουργία του κεντρικού νευρικού συστήματος, όπως 

διανοητική καθυστέρηση, προβλήματα συμπεριφοράς και προβλήματα ύπνου [2] 

ενώ έχουν αναφερθεί και καρδιοπάθειες [1]. Είναι δύσκολο να υπολογιστεί η 

σοβαρότητα της επίδρασης της αιθανόλης στο έμβρυο καθώς αυτή εξαρτάται από 

πολλούς παράγοντες όπως η χρονική διάρκεια κατανάλωσης αλκοόλ από τη μητέρα 

κατά τη διάρκεια της εγκυμοσύνης, το γενετικό υπόβαθρο του εμβρύου, η 

ικανότητα της μητέρας να μεταβολίζει την αιθανόλη καθώς και το στάδιο της 

ανάπτυξης του εμβρύου που θα γίνει η έκθεση. Η αιθανόλη μπορεί εύκολα να 

διέλθει μέσω του πλακούντα από τη μητέρα στο έμβρυο και μέσα σε 2 ώρες η 

συγκέντρωση αιθανόλης στο αίμα της μητέρας να είναι ίδια με αυτή στο αίμα του 

εμβρύου [1]. Επιπλέον, η μεταβολική δραστηριότητα του εμβρύου είναι μικρότερη 

από αυτή της μητέρας και έτσι η αιθανόλη μπορεί να παραμείνει στο έμβρυο 

μεγαλύτερο χρονικό διάστημα σε σχέση με τη μητέρα [1]. Εξαιτίας της τερατογόνου 

δράσης της αιθανόλης και των πολλών προβλημάτων που μπορεί να προκαλέσει 

στο αναπτυσσόμενο έμβρυο σε όλη τη διάρκεια της κύησης και παρόλο που έχουν 

καθοριστεί τα ασφαλή όρια ως προς την κατανάλωση αιθανόλης κατά την 

εγκυμοσύνη, συστήνεται στις εγκυμονούσες να απέχουν πλήρως από την αιθανόλη 

[1].  

Η διάγνωση του FAS θεωρείται δύσκολη στα παιδιά καθώς δεν υπάρχει 

κάποιο τεστ και τα συμπτώματα είναι παρόμοια και με άλλες διαταραχές όπως η 

διαταραχή ελλειμματικής προσοχής και υπερκινητικότητας και το σύνδρομο 
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Williams [1]. Για αυτό τον λόγο πολλές φορές η διάγνωση στην αρχή μπορεί να γίνει 

λανθασμένα [5,6].  

Το FAS είναι μη αναστρέψιμη διαταραχή όμως με κατάλληλη διαχείριση τα 

συμπτώματα μπορεί να περιοριστούν. Αυτό μπορεί να γίνει με εφαρμογή 

προσαρμοσμένης εκπαίδευσης και κατάλληλη θεραπεία για βελτίωση της 

συμπεριφοράς η οποία όσο πιο σύντομα εφαρμοστεί θα έχει και μεγαλύτερη 

αποτελεσματικότητα. Σημαντικό είναι, ακόμα, να υπάρχει ένα καλό και σταθερό 

οικογενειακό περιβάλλον στο οποίο θα μεγαλώσει το παιδί [1]. 

Υπολογίζεται ότι η συχνότητα εμφάνισης του FAS είναι 2,9 στις 1000 γεννήσεις 

παγκοσμίως ενώ το ποσοστό των γυναικών που καταναλώνουν αιθανόλη κατά την 

εγκυμοσύνη φαίνεται να αυξάνεται· από 7,6% το 2012 σε 10,2% το 2015 και έτσι 

φαίνεται να αυξάνεται και η συχνότητα εμφάνισης FAS τα επόμενα χρόνια. Το FAS 

αποτελεί την πιο συχνή μορφή συνδρόμου διανοητικής καθυστέρησης που δεν 

είναι κληρονομήσιμη [1]. 

 

Εικόνα 1: Χαρακτηριστικές δυσμορφίες στο πρόσωπο παιδιών που πάσχουν από FAS [1]. 
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Ζωικά μοντέλα εμβρυϊκού αλκοολικού συνδρόμου και σύγκριση με τον άνθρωπο 

Τα ζωικά μοντέλα αποτελούν ένα χρήσιμο εργαλείο για τη μελέτη του FAS και είναι 

κατάλληλα για την διαλεύκανση των μηχανισμών με τους οποίους η αιθανόλη 

προκαλεί τοξικότητα καθώς παρόμοιες αναλύσεις και μελέτες είναι αδύνατο να 

εφαρμοστούν στους ανθρώπους. Επίσης, οι μελέτες αυτές θεωρούνται πιο 

αξιόπιστες καθώς, σε αντίθεση με τους ανθρώπους, παράμετροι όπως η ποσότητα 

της αιθανόλης και το στάδιο στο οποίο γίνεται η έκθεση είναι ελεγχόμενα. Ζωικά 

μοντέλα που έχουν χρησιμοποιηθεί είναι ο Caenorhabditis elegans, το Danio rerio 

(ψάρι ζέβρα) καθώς και θηλαστικά όπως πρωτεύοντα, επίμυες και ποντίκια με 

καθένα από αυτά να έχουν πλεονεκτήματα και μειονεκτήματα και η επιλογή τους 

να γίνεται ανάλογα με το αντικείμενο μελέτης. Οι επίμυες θεωρούνται το πιο 

κατάλληλο μοντέλο για τη μελέτη του FAS, παρόλο που το συχνότερα 

χρησιμοποιούμενο μοντέλο είναι οι ποντικοί, γιατί είναι εύκολα διαχειρίσιμοι, 

παράγουν μεγάλο αριθμό απογόνων, έχουν μικρή χρονική περίοδο κύησης ενώ 

είναι και μεγαλύτεροι σε μέγεθος από τους ποντικούς [3]. 

 

Εικόνα 2: Τα τρία τρίμηνα της κύησης του ανθρώπου σε αντιστοιχία με τον επίμυ. Όπως φαίνεται, το 
πρώτο τρίμηνο του ανθρώπου αντιστοιχεί στις πρώτες 10 μέρες από την σύλληψη στον επίμυ, το 
δεύτερο από την μέρα 11 μέχρι τη μέρα 21 όπου και γίνεται η γέννηση στον επίμυ και το τρίτο 
τρίμηνο στις πρώτες 10 μέρες μετά τη γέννηση του επίμυος. GD: gestational day, προγεννητική 
ημέρα, PND: postnatal day, μεταγεννητική ημέρα [3]. 

 

Το μεγαλύτερο μειονέκτημα που έχουν οι επίμυες είναι ότι τα στάδια ανάπτυξης 

που αντιστοιχούν στο τρίτο τρίμηνο της ανθρώπινης κύησης πραγματοποιούνται 

μετά τη γέννηση τους. Το γεγονός αυτό, μπορεί να οδηγήσει σε εσφαλμένα 

αποτελέσματα στην μελέτη της επίδρασης στην αιθανόλη κατά το χρονικό διάστημα 

που αντιστοιχεί στο τρίτο τρίμηνο της ανθρώπινης κύησης μια και παράμετροι όπως 
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ο τρόπος που γίνεται η πρόσληψη της αιθανόλης από το έμβρυο διαφέρουν (Εικόνα 

2). Ανάλογα το πότε θα γίνει η έκθεση του εμβρύου στην αιθανόλη φαίνεται να 

υπάρχουν διαφορετικές αναπτυξιακές διαδικασίες του εγκεφάλου που 

επηρεάζονται και ως αποτέλεσμα να προκύπτει διαφορετικός φαινότυπος (Εικόνα 

3) [3]. Για παράδειγμα, η πρόσληψη αιθανόλης το χρονικό διάστημα που 

αντιστοιχεί στο 1ο τρίμηνο της ανθρώπινης κύησης συνεπάγεται προβλήματα στις 

διαδικασίες γαστριδίωσης και νευριδίωσης ενώ φαινοτυπικά παρατηρείται 

δυσμορφία του κρανίου, στο 2ο τρίμηνο επηρεάζονται διαδικασίες όπως η 

συναπτογένεση και η μυελίνωση, με αποτέλεσμα την περιορισμένη ανάπτυξη του 

εμβρύου, ενώ έκθεση στο 3ο τρίμηνο έχει ως αποτέλεσμα διαταραχές στον 

πολλαπλασιασμό των αστρογλοιακών κυττάρων και ολιγοδενδροκυττάρων και 

προκύπτουν νευρολογικές διαταραχές [3]. 

 

Εικόνα 3: Αναπτυξιακές διαδικασίες στις οποίες η αιθανόλη προκαλεί βλάβη στον επίμυ ανάλογα με 
το τρίμηνο, κατά αντιστοιχία με την κύηση στον άνθρωπο, που συμβαίνει η έκθεση και ο φαινότυπος 
που προκύπτει σε κάθε περίπτωση. GD: gestational day προγεννητική ημέρα, PND: postnatal day 
μεταγεννητική ημέρα [3] 
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Περιοχές που επηρεάζονται από την προγεννητική έκθεση στην αιθανόλη 

Η προγεννητική έκθεση στην αιθανόλη προκαλεί δυσλειτουργία σε διάφορες 

διεργασίες για τις οποίες είναι υπεύθυνες διαφορετικές περιοχές του εγκεφάλου. 

Είναι λοιπόν λογικό να έχουν γίνει μελέτες πάνω στην επίδραση της αιθανόλης σε 

περιοχές οι οποίες είναι υπεύθυνες για τις διεργασίες που επηρεάζονται από την 

έκθεση στην αιθανόλη. Με βάση αυτό περιοχές όπως ο μέσος προμετωπιαίος 

φλοιός [7], το ραβδωτό σώμα [8], ο επικλινής πυρήνας που αποτελεί μέρος του 

ραβδωτού σώματος [8], η αμυγδαλή [9], το μεσολόβιο [10, 11, 12, 13, 14], ο 

ενωτικός θαλαμικός πυρήνας [15], o απειοειδής φλοιός [9] και ο ιππόκαμπος [1, 8] 

είναι περιοχές που ελέγχθηκαν και φαίνεται να επηρεάζονται από την αιθανόλη. 

Κάποιες από αυτές τις περιοχές που είναι υπό μελέτη στην παρούσα εργασία 

αναλύονται περισσότερο παρακάτω. 

 

Μέσος προμετωπιαίος φλοιός (medial prefrontal cortex) 

Ο μέσος προμετωπιαίος φλοιός διακρίνεται σε 6 (I-VI) στιβάδες και σε 4 περιοχές οι 

οποίες είναι η μεσαία προκεντρική περιοχή (medial precentral area, PrCm), ο 

πρόσθιος φλοιός του προσαγωγίου (anterior cingulate cortex, ACC), ο 

προμεταιχμιακός φλοιός (prelimbic cortex, PrL), ο κατώτερος μεταιχμιακός φλοιός 

(infralimbic cortex, IL, εικόνα 4) [16]. Οι κυτταρικοί τύποι που χαρακτηρίζουν τον 

προμετωπιαίο φλοιό είναι σε μεγάλο ποσοστό διεγερτικοί πυραμιδικοί νευρώνες 

ενώ υπάρχουν και ανασταλτικοί GABAεργικοί ενδονευρώνες. Ο φλοιός αυτός 

δέχεται νεύρωση από πολλές περιοχές του εγκεφάλου ενώ παράλληλα νευρώνες 

από την περιοχή αυτή καταλήγουν σε ποικίλες δομές στον εγκέφαλο. Συγκεκριμένα, 

ο μέσος προμετωπιαίος φλοιός δέχεται νεύρωση από περιοχές όπως ο θάλαμος, οι 

πλαγιοβασικοί πυρήνες της αμυγδαλής και ο ιππόκαμπος ενώ νευρώνες που 

ξεκινούν από την περιοχή αυτή προεκβάλλουν σε περιοχές όπως το κεντρικό τμήμα 

και το κέλυφος του επικλινούς πυρήνα και η αμυγδαλή [16].  

Σε ότι αφορά στον λειτουργικό του ρόλο, ο μέσος προμετωπιαίος φλοιός έχει 

κομβικό ρόλο σε γνωστικές διεργασίες, στο κίνητρο, την αντίληψη αλλά και στα 

συναισθήματα και την κοινωνική συμπεριφορά ενώ δυσλειτουργία της περιοχής 
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αυτής έχει συσχετιστεί με την εμφάνιση παθολογικών καταστάσεων όπως 

κατάθλιψη, σχιζοφρένεια, νόσο Alzheimer και εθισμό (εικόνα 5) [16]. 

 
Εικόνα 4: Απεικόνιση των περιοχών PrCm (medial precentral area), ACC (anterior cingulate cortex), PL 
(prelimbic cortex), IL (infralimbic cortex) στους οποίους διακρίνεται ο προμετωπιαίος φλοιός κατά 
μήκος του ραχιοκοιλιακού άξονα ενώ φαίνεται και η οργάνωση της περιοχής σε 6 στιβάδες (Ι-IV). 
Επίσης, είναι διακριτοί διεγερτικοί πυραμιδικοί νευρώνες (PN) και ενδονευρώνες παρβαλουμίνης 
(PV) που είναι τύπος GABAεργικών ενδονευρώνων και οι διασυνδέσεις μεταξύ τους [16]. 

 

 
Εικόνα 5: Διασυνδέσεις του μέσου προμετωπιαίου φλοιού με διάφορες περιοχές του εγκεφάλου. 
Όταν υπάρχει ομαλή λειτουργία των διασυνδέσεων αυτών ρυθμίζονται σωστά και διεργασίες για τις 
οποίες έχει σημαντικό ρόλο ο προμετωπιαίος φλοιός ενώ σε αντίθετη περίπτωση μπορούν να 
εμφανιστούν ασθένειες. BLA: basolateral amygdala, NAc: nucleus accumbens, MT: midline thalamus, 
HTH: hypothalamus, VTA: ventral tegmental area, Hipp: hippocampus, DRN: dorsal raphe nucleus 
[16]. 
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Ραβδωτό σώμα (striatum) 

Το ραβδωτό σώμα διακρίνεται σε 3 περιοχές τον κερκοφόρο πυρήνα (caudate 

nucleus), το κέλυφος φακοειδούς πυρήνα (putamen nucleus) και την κοιλιακή 

περιοχή του ραβδωτού σώματος (ventral striatum) στην οποία βρίσκεται ο επικλινής 

πυρήνας (εικόνα 6). Ανάμεσα στον κερκοφόρο πυρήνα και το κέλυφος, που 

αποτελούν τη ραχιαία περιοχή του ραβδωτού σώματος (dorsal striatum), υπάρχει 

μία δομή λευκής ουσίας η οποία ονομάζεται έσω κάψα (internal capsule) και 

χωρίζει τις δύο αυτές περιοχές [1]. 

 
Εικόνα 6: Σχηματική απεικόνιση των περιοχών που αποτελείται το ραβδωτό σώμα. Είναι διακριτός ο 
κερκοφόρος πυρήνας (caudate) και το κέλυφος φακοειδούς πυρήνα (putamen) με πορτοκαλί χρώμα 
που αποτελούν τη ραχιαία περιοχή του ραβδωτού σώματος και ο επικλινής πυρήνας (nucleus 
accumbens) με κόκκινο χρώμα που αποτελεί την κοιλιακή περιοχή του ραβδωτού σώματος [43]. 
 

Το ραβδωτό σώμα αποτελείται σε μεγαλύτερο ποσοστό από τους μέσους 

ακανθώδεις νευρώνες (medium spiny neurons, MSNs) οι οποίοι είναι GABAεργικοί 

και διακρίνονται στον D1 και D2 τύπο ανάλογα με το είδος του ντοπαμινικού 

υποδοχέα που εκφράζουν. Εκτός από τους MSNs στην περιοχή υπάρχουν και άλλοι 

τύποι νευρώνων οι οποίοι είναι χολινεργικοί και GABAεργικοί ενδονευρώνες [1]. 

Σχετικά με τις διασυνδέσεις με άλλες περιοχές, το ραβδωτό σώμα δέχεται νεύρωση 

από το φλοιό, το θάλαμο, την αμυγδαλή και από τις περιοχές του κογχομετωπιαίου 

φλοιού (orbitofrontal cortex) και του πρόσθιου φλοιού του προσαγωγίου (anterior 

cingulate cortex, ACC) που είναι περιοχές του προμετωπιαίου φλοιού. Από το 

ραβδωτό σώμα ξεκινούν MSN νευρώνες τύπου D1 οι οποίοι καταλήγουν στην 
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δικτυωτή μοίρα της μέλαινας ουσίας (substantia nigra pars reticulata, SNr) και 

διαμορφώνουν την άμεση απαγωγική οδό ενώ MSN νευρώνες τύπου D2 από το 

ραβδωτό σώμα καταλήγουν στην ωχρά σφαίρα (globus pallidus, GPe) και 

διαμορφώνουν την έμμεση απαγωγική οδό (εικόνα 7). Η βασικότερη λειτουργία 

που έχει το ραβδωτό σώμα είναι ο έλεγχος της εκούσιας κίνησης αλλά φαίνεται να 

εμπλέκεται και σε άλλες λειτουργίες που είναι γνωστικές διεργασίες και η 

ανταμοιβή [1]. 

 

 

Εικόνα 7: Το ραβδωτό σώμα δέχεται νεύρωση από διάφορες περιοχές όπως ο φλοιός, η αμυγδαλή 
και ο θάλαμος. Επίσης, φαίνεται η άμεση (Direct pathway) και έμμεση (Indirect pathway) απαγωγική 
οδός με νευρώνες από το ραβδωτό σώμα να καταλήγουν στις περιοχές της δικτυωτής μοίρας της 
μέλαινας ουσίας (SNr) και της ωχράς σφαίρας (GP) αντίστοιχα. DLS: Dorsolateral Striatum, DMS: 
Dorsomedial Striatum, GP: Globus Pallidus, NAc: Nucleus Accumbens, SNc: Substancia Nigra pars 
compacta, SNr: Substancia Nigra pars reticulata, STN: Subthalamic Nucleus, VTA: Ventral Tegmental 
Area [18]. 

 

Επικλινής πυρήνας (nucleus accumbens) 

Όπως προαναφέρθηκε, ο επικλινής πυρήνας αποτελεί την κοιλιακή περιοχή του 

ραβδωτού σώματος και είναι μέρος αυτού (εικόνα 6). Όσον αφορά τη δομή του 

χωρίζεται σε δύο διακριτές περιοχές οι οποίες είναι το κεντρικό τμήμα (core) και το 
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κέλυφος (shell). Οι δύο αυτές περιοχές πιθανολογείται ότι έχουν διαφορές στην 

λειτουργία τους καθώς βρέθηκαν διαφορές που αφορούν τη συνδεσιμότητα τους 

με άλλες περιοχές. Ο τύπος των νευρώνων που επικρατεί στον επικλινή πυρήνα 

είναι, όπως και στο υπόλοιπο ραβδωτό σώμα, οι μέσοι ακανθώδεις νευρώνες 

(MSNs) ενώ να υπάρχουν επίσης χολινεργικοί και GABAεργικοί ενδονευρώνες [19]. 

Στο κεντρικό τμήμα του επικλινούς πυρήνα φαίνεται να υπάρχει μεγαλύτερη 

πυκνότητα δενδριτικών ακάνθων και διακλαδώσεων των μέσων ακανθωδών 

νευρώνων σε σχέση με το κέλυφος [20]. 

 

Εικόνα 8: Γλουταμινεργικοί νευρώνες από τον προμετωπιαίο φλοιό, τον ιππόκαμπο και την 
αμυγδαλή καθώς και ντοπαμινεργικοί νευρώνες από την κοιλιακή καλυπτρική περιοχή (VTA) 
καταλήγουν στον επικλινή πυρήνα προκαλώντας διέγερσή του ενώ GABAεργικοί νευρώνες από τον 
πυρήνα προκαλούν ανασταλτικά σήματα προς περιοχές όπως ο υποθάλαμος, η ωχρά σφαίρα και η 
κοιλιακή καλυπτρική περιοχή. vSub: ventral subiculum, VTA: ventral tegmental area [19]. 

 

Όπως αναφέρθηκε και για το ραβδωτό σώμα, νευρώνες που ξεκινούν από τον 

προμετωπιαίο φλοιό και την αμυγδαλή καταλήγουν στον επικλινή πυρήνα. Περιοχές 

όπως ο ιππόκαμπος και η κοιλιακή καλυπτρική περιοχή (ventral tegmental area, 

VTA) νευρώνουν τον επικλινή πυρήνα ενώ παράλληλα νευρώνες από τον πυρήνα 

καταλήγουν σε περιοχές όπως η ωχρά σφαίρα, ο υποθάλαμος και η κοιλιακή 

καλυπτρική περιοχή (εικόνα 8) [19]. Ο επικλινής πυρήνας θεωρείται το κέντρο της 



- 14 - 
 

ανταμοιβής και των κινήτρων στον εγκέφαλο, έχει άμεση σχέση με τον εθισμό ενώ 

μπορεί να ωθήσει σε αρνητικές συμπεριφορές [21]. 

 

Μεσολόβιο (corpus callosum) 

Το μεσολόβιο είναι η μεγαλύτερη δομή του εγκεφάλου που αποτελείται από λευκή 

ουσία και διακρίνεται σε 5 επιμέρους μέρη τα οποία είναι το ρύγχος (rostrum), το 

γόνατο (genu), το σώμα (body), τον ισθμό (isthmus) και το σπλήνιο (splenium). 

(εικόνα 9). Το μέγεθος από το ρύγχος μέχρι το σπλήνιο κυμαίνεται από 7,7 μέχρι 8,2 

εκατοστά ενώ το πλάτος είναι διαφορετικό σε κάθε υποπεριοχή του. Στο μεσολόβιο 

υπάρχουν εκατομμύρια νευρικές ίνες που συνδέουν τα δύο εγκεφαλικά 

ημισφαίρια, με το ρύγχος να αποτελεί τη δίοδο επικοινωνίας ανάμεσα στο δεξί και 

αριστερό μέρος του μετωπιαίου λοβού και κατά αντιστοιχία το σπλήνιο να 

συμβάλει στην επικοινωνία του δεξιού και αριστερού μέρους του ινιακού λοβού 

(εικόνα 9) [22, 44]. 

 

Εικόνα 9: Οβελιαία τομή του εγκεφάλου όπου διακρίνεται το μεσολόβιο και οι διάφορες 
υποπεριοχές του (αριστερά). Περιοχές στον φλοιό από τις οποίες ξεκινάνε νευρικές ίνες και περιοχές 
στο μεσολόβιο μέσω του οποίου διέρχονται για να καταλήξουν στις αντίστοιχες περιοχές του άλλου 
ημισφαιρίου. Κάθε περιοχή του φλοιού και του μεσολοβίου είναι σημασμένη με τρόπο ώστε να 
φαίνεται από ποια σημεία του μεσολοβίου διέρχονται οι ίνες κάθε περιοχής του φλοιού (δεξιά) [23]. 

 

Ο βασικότερος λειτουργικός ρόλος του μεσολοβίου είναι η επικοινωνία ανάμεσα 

στο δεξί και αριστερό ημισφαίριο του εγκεφάλου ώστε να υπάρχει συγχρονισμένη 
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λειτουργία των αντίστοιχων περιοχών σε κάθε ημισφαίριο και διαταραχή στον 

συγχρονισμό αυτό, όπως όταν υπάρχει αγένεση του μεσολοβίου, σχετίζεται με 

πολλές παθολογικές καταστάσεις και προβλήματα για παράδειγμα στον συντονισμό 

των κινήσεων στο περπάτημα και στην κατάποση. Ένας άλλος λειτουργικός ρόλος 

του μεσολοβίου πιθανολογείται ότι είναι η συμμετοχή του σε διάφορες γνωστικές 

διεργασίες καθώς προβλήματα στο μεσολόβιο έχουν συσχετιστεί με δυσλειτουργία 

στις διεργασίες αυτές [22, 44, 23]. 

 

Αμυγδαλή (amygdala) 

Η αμυγδαλή βρίσκεται στον κροταφικό λοβό (εικόνα 10) και δομικά μπορεί να 

διακριθεί σε πολλούς πυρήνες με την βασική πλάγια αμυγδαλή (basolateral 

amygdala, BLA), την κεντρική αμυγδαλή (central amygdala, CeA) και την μέση 

αμυγδαλή (medial amygdala, MeA) να είναι οι κυριότεροι και πιο μελετημένοι [24].  

 

Εικόνα 10: Στην εικόνα μπορεί να παρατηρηθεί η θέση στης αμυγδαλής στον κροταφικό λοβό του 
εγκεφάλου [45]. 

 

Οι τύποι νευρώνων στην περιοχή της βασικής πλάγιας αμυγδαλής είναι κυρίως 

πυραμιδικού τύπου ακανθώδεις νευρώνες (pyramidal-like spiny neurons) και 

υπάρχουν και διάφοροι άλλοι τύποι όπως GABAεργικοί νευρώνες τύπου S με 
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μικρότερα σε μέγεθος σώματα από τους πυραμιδικούς. Στην κεντρική αμυγδαλή 

επικρατούν οι μέσοι ακανθώδεις νευρώνες (MSNs) ενώ έχουν αναφερθεί και άλλοι 

τύποι με μεγαλύτερα σε μέγεθος σώματα. Γενικά, η μορφολογία των νευρώνων 

στην περιοχή της βασικής-πλάγιας αμυγδαλής, της κεντρικής αμυγδαλής και της 

μέσης αμυγδαλής διαφέρει, με την πρώτη να χαρακτηρίζεται από νευρώνες που 

μοιάζουν στην μορφολογία με αυτούς στην περιοχή του φλοιού και τη δεύτερη και 

τρίτη να έχει νευρώνες με μορφολογία παρόμοια αυτών του ραβδωτού σώματος 

[25].  

 

Εικόνα 11: Περιοχές από τις οποίες ξεκινούν νευρώνες οι οποίοι καταλήγουν και νευρώνουν τους 3 
βασικότερους πυρήνες της αμυγδαλής (μπλε χρώμα) και περιοχές στις οποίες καταλήγουν νευρώνες 
που ξεκινούν από τους πυρήνες της αμυγδαλής (πορτοκαλί χρώμα). Επίσης, διακρίνονται οι 
διασυνδέσεις που έχουν οι πυρήνες της αμυγδαλής μεταξύ τους καθώς και ο λειτουργικός ρόλος που 
έχει κάθε διασύνδεση της αμυγδαλής με την περιοχή που νευρώνει. BA: basal amygdala, BF: basal 
forebrain, BNST: bed nucleus of the stria terminalis, CeA: central amygdala, DRN: dorsal raphe 
nucleus, EC: entorhinal cortex, GABAergic: gamma-aminobutyric acidergic, LA: lateral amygdala, LC: 
locus coeruleus, MeA: medial amygdala, mPFC: medial prefrontal cortex, NAC: nucleus accumbens, 
NTS: nucleus of the solitary tract, PAG: periaqueductal gray, PBN: parabrachial nucleus, SNL: lateral 
substantia nigra, VTA: ventral tegmental area [24]. 

 

Η αμυγδαλή δέχεται νεύρωση από πολλές περιοχές όπως από τον θάλαμο, το 

στέλεχος, τους οσφρητικούς βολβούς, τον συνειρμικό φλοιό και την ευρύτερη 

περιοχή του προμετωπιαίου φλοιού αλλά και από την κοιλιακή καλυπτρική περιοχή 

και τους πυρήνες της ραφής (εικόνα 11). Από την αμυγδαλή ξεκινούν νευρώνες οι 
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οποίοι καταλήγουν στον προμετωπιαίο φλοιό, τον ιππόκαμπο, τον βασικό πρόσθιο 

εγκέφαλο (basal forebrain), το στέλεχος, τον υποθάλαμο, την κοιλιακή καλυπτρική 

περιοχή και την μέλαινα ουσία (εικόνα 11) [24]. 

Σχετικά με τον λειτουργικό της ρόλο, η αμυγδαλή σχετίζεται με την απόκριση στον 

φόβο, το στρες, το άγχος και τον θυμό, ενώ φαίνεται, ακόμα ότι συμμετέχει και με 

τις διεργασίες της μάθησης και της μνήμης, κυρίως όταν αφορούν ένα ερέθισμα 

που προκαλεί φόβο [24]. 

 

Επίδραση της προγεννητικής έκθεσης στην αιθανόλη σε ζωικά μοντέλα με 

έμφαση στις υπό μελέτη περιοχές  

Ζωικά μοντέλα έχουν δείξει ότι το FAS έχει σημαντική επίδραση σε διάφορες 

περιοχές του εγκεφάλου. Στη μελέτη του Gursky και συν. (2020) παρατηρήθηκε 

κυτταρικός θάνατος νευρώνων στον ενωτικό θαλαμικό πυρήνα (thalamic nucleus 

reuniens) [15]. Ο ρόλος του πυρήνα αυτού είναι να αποτελεί δίοδο επικοινωνίας 

μεταξύ του προμετωπιαίου φλοιού και του ιπποκάμπου ενώ συντονίζει λειτουργίες 

των δύο αυτών περιοχών όπως η μνήμη. Παρά το ότι ο ιππόκαμπος παρέχει 

μονοσυναπτικές προεκβολές προς τον πρωμετοπιαίο φλοιό, η γέφυρα επικοινωνίας 

των δύο αυτών περιοχών μέσω του ενωτικού θαλαμικού πυρήνα είναι η κυριότερη 

οδός σύνδεσης τους και με καταστροφή του πυρήνα φαίνεται να προκαλείται 

δυσλειτουργία στην οδό αυτή [15]. Στη μελέτη αυτή χορηγήθηκαν συνολικά 

5,25g/kg αιθανόλης σε επίμυες Long Evans σε δύο δόσεις που διέφεραν 2 ώρες 

μεταξύ τους την 7η μέρα μετά τη γέννηση. Τα αποτελέσματα της μελέτης αυτής 

έδειξαν ότι 12 ώρες μετά τη χορήγηση αιθανόλης υπάρχει στατιστικά σημαντική 

αύξηση των κυττάρων που βρίσκονται σε απόπτωση στον ενωτικό θαλαμικό πυρήνα 

σε σχέση με τα ζώα ελέγχου. Παρόμοια αποτελέσματα φάνηκαν και την 11η μέρα 

μετά τη γέννηση (4η μέρα μετά τη χορήγηση αιθανόλης) καθώς παρατηρήθηκε 

μείωση στον συνολικό αριθμό κυττάρων στον ενωτικό θαλαμικό πυρήνα, ενώ στην 

72η μέρα μετά τη γέννηση παρατηρήθηκε επίσης μείωση στον συνολικό αριθμό των 

κυττάρων του πυρήνα αλλά και μείωση ειδικά στα νευρικά κύτταρα στην περιοχή 

αυτή [15]. 
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Η περιοχή του μέσου προμετωπιαίου φλοιού (mPrC) φαίνεται επίσης να 

επηρεάζεται από την αιθανόλη. Η έκθεση C57BL/6 ποντικών ηλικίας 7-8 εβδομάδων 

σε ατμούς αιθανόλης για 8 ώρες καθημερινά για 30 μέρες έδειξε αύξηση στην 

διαδικασία της νεκρόπτωσης μέσω του μονοπατιού RIP1/RIP3/MLKL [7]. Μέσω της 

μεθόδου ανοσοαποτύπωσης πρωτεϊνών κατά Western (Western blot) που 

πραγματοποιήθηκε την 15η μέρα έκθεσης στην αιθανόλη παρατηρήθηκε αύξηση 

στα επίπεδα των φωσφορυλιωμένων μορφών των πρωτεϊνών RIP1, RIP3 και MLKL 

σε σχέση με τα ζώα ελέγχου ενώ τα επίπεδα των φωσφορυλιωμένων μορφών τους 

φάνηκαν να παραμένουν σταθερά [7]. Η αύξηση των επιπέδων αυτών ενισχύθηκε 

30 μέρες μετά την πρώτη έκθεση στην αιθανόλη, κάτι που δείχνει την αντίστοιχη 

ενίσχυση στην διαδικασία της νεκρόπτωσης την 30η μέρα της έκθεσης. Να 

σημειωθεί ότι στις 30 μέρες παρατηρήθηκε και στατιστικά σημαντική αύξηση της μη 

φωσφορυλιωμένης μορφής της πρωτεΐνης MLKL. Επίσης, με διπλό ανοσοφθορισμό 

που πραγματοποιήθηκε την συγκεκριμένη χρονική στιγμή φάνηκε αύξηση της 

ανοσοδραστικότητας της πρωτεΐνη MLKL (δείκτης νεκρόπτωσης) στα νευρικά 

κύτταρα (συνεντοπισμός με το NeuN ως δείκτη [26]) στα ζώα που εκτέθηκαν σε 

αιθανόλη σε σχέση με τα ζώα ελέγχου, κάτι που επιβεβαιώνει την ενίσχυση της 

νεκρόπτωσης στα νευρικά κύτταρα στα αλκοολικά ζώα. Αντίστοιχη αύξηση της 

νεκρόπτωσης δεν παρατηρήθηκε στα αστρογλοιακά κύτταρα (GFAP ως δείκτης). 

Τέλος,  παρατηρήθηκε η μορφολογία των κυττάρων του προμετωπιαίου φλοιού με 

τη βοήθεια ηλεκτρονικού μικροσκοπίου και δείχθηκε στα αλκοολικά ζώα υπήρχαν 

σημάδια νέκρωσης, μια και τα κύτταρα χαρακτηριζόταν από υπερβολικά αυξημένα 

μιτοχόνδρια και διάλυση του ενδοπλασματικού δικτύου σε σχέση με τα ζώα 

έλεγχου [7]. 

Μία ακόμα περιοχή που επηρεάζεται από την προγεννητική έκθεση στην αιθανόλη 

είναι το ραβδωτό σώμα. Σε ποντίκια τύπου C57BL/6J κατά την εγκυμοσύνη 

χορηγήθηκε, την προγεννητική μέρα 8, ενδοπεριτονιακά διάλυμα αιθανόλης 23,7% 

v/v σε δύο δόσεις με 4 ώρες διαφορά όπου κάθε δόση ήταν 2.8 g/kg με σκοπό την 

παρατήρηση της επίδρασης της αιθανόλης κατά τη διαδικασία της νευριδίωσης. 

Από τα αποτελέσματα φάνηκε στατιστικά σημαντική διαφορά στο σχήμα του 

ραβδωτού σώματος αλλά όχι στο όγκο του [27]. Από άλλες μελέτες φάνηκε ότι η 
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προγεννητική έκθεση στην αιθανόλη προκάλεσε αύξηση στον αριθμό και στις 

διασυνδέσεις των δενδριτικών ακανθών των μέσων ακανθωδών νευρώνων 

(medium spiny neurons, MSNs) στην ραχιαία περιοχή του ραβδωτού σώματος [28]. 

Τέλος, βρέθηκε ότι η καθημερινή έκθεση στην αιθανόλη σε ποσότητα 6g/kg από την 

προγεννητική μέρα 7 μέχρι 20 σε επίμυες Sprague-Dawley προκάλεσε μειωμένη 

αύξηση ηλεκτρικού δυναμικού (population spike) στους επίμυες που εκτέθηκαν σε 

σχέση με την ομάδα ελέγχου και κατά συνέπεια μειωμένο LTP (Long-Term 

Potensiation) στην πλαγιοραχιαία περιοχή του ραβδωτού σώματος όταν έγινε 

διέγερση υψηλής συχνότητας (high-frequency stimulation, HFS) την μέρα 15 μετά τη 

γέννηση. Με τον ίδιο τρόπο έγινε διέγερση υψηλής συχνότητας την μέρα 30 και 40 

μετά τη γέννηση και προκλήθηκε LTD (Long-Term Depression) στους επίμυες της 

ομάδας ελέγχου αλλά ξανά LTP στους επίμυες που εκτέθηκαν προγεννητικά στην 

αιθανόλη. Αυτό το μη φυσιολογικό LTP φαίνεται να προκλήθηκε από μεταβολές 

που προκάλεσε η αιθανόλη στους υποδοχείς ντοπαμίνης D1R και D2R [29]. 

Ο επικλινής πυρήνας (NAC) είναι άλλη μία περιοχή που φαίνεται να επηρεάζεται 

από την προγεννητική έκθεση στην αιθανόλη. Σε μια μελέτη του Lawrence και συν. 

(2011) χορηγήθηκαν 4,5g/kg αιθανόλης σε 20ml/kg απεσταγμένο νερό καθημερινά 

για όλη τη διάρκεια της προγεννητικής περιόδου σε επίμυες Long-Evans με 

ενδογαστρικό σωλήνα [8]. Επίσης, έγινε χορήγηση 3g/kg αιθανόλης σε 27,8ml/kg 

γάλακτος από τη 2η μέχρι τη 10η μεταγεννητική μέρα στα νεογέννητα ζώα. Την 

μεταγεννητική μέρα 90 έγινε η απομόνωση του εγκεφάλου από τους επίμυες και 

διαπιστώθηκε ότι δεν υπήρχαν στατιστικά σημαντικές διαφορές στον αριθμό των 

νευρικών κυττάρων στο κεντρικό τμήμα (core) και στο κέλυφος (shell) του πυρήνα 

ανάμεσα στα ζώα ελέγχου και σε αυτά που εκτέθηκαν σε αιθανόλη. Επίσης, δεν 

φάνηκαν διαφορές στην πυκνότητα των δενδριτικών προεκβολών (dendritic spines) 

και γενικότερα στη μορφολογία των δενδριτών καθώς και στο μέγεθος του 

κυτταρικού σώματος. Στατιστική σημαντική αύξηση υπήρχε στον αριθμό των 

επαφών μεταξύ των δενδριτών (dendritic branch intersections) στα θηλυκά που 

εκτέθηκαν σε αιθανόλη σε σχέση με τα αρσενικά και τα θηλυκά ζώα ελέγχου, ενώ 

τέτοια διαφορά δεν φάνηκε όταν εξετάστηκαν όλα τα ζώα μαζί ανεξαρτήτως φύλου 

[8]. Από άλλες μελέτες δείχθηκε ότι η χρόνια έκθεση στην αιθανόλη επηρεάζει τις 
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δενδριτικές προεκβολές στην περιοχή του επικλινή πυρήνα καθώς και 

συμπεριφορές που ελέγχονται από αυτόν [30]. Αυτό μπορεί να οφείλεται στη 

μεταβολή της νεύρωσης που δέχεται ο πυρήνας από άλλες περιοχές του εγκεφάλου 

εξαιτίας της αιθανόλης, για παράδειγμα από την γλουταμινεργική νεύρωση του 

προμετωπιαίου φλοιού, αφού στην μελέτη του Lawrence και συν. (2011) δεν 

φάνηκε η αιθανόλη να επηρεάζει άμεσα τον επικλινή πυρήνα αλλά να επηρεάζει 

άμεσα τον προμετωπιαίο φλοιό [8]. 

Η αιθανόλη μπορεί να προκαλέσει θάνατο νευρώνων στην περιοχή της κεντρικής 

αμυγδαλής. Στη μελέτη του V. Balaszczuk και συν. (2011) χορηγήθηκε διάλυμα 20% 

v/v αιθανόλης υποδόρια σε επίμυες wistar σε 2 δόσεις με 2 ώρες διαφορά όπου η 

κάθε δόση περιείχε 2,5g/kg αιθανόλη τις μεταγεννητικές μέρες 7, 15 και 20 [9]. Τα 

αποτελέσματα έδειξαν αύξηση στον αριθμό των εκφυλισμένων νευρώνων στην 

περιοχή της κεντρικής αμυγδαλής στα ζώα που εκτέθηκαν στην αιθανόλη σε σχέση 

με τα ζώα ελέγχου. Η παρατήρηση έγινε τις ημέρες 7, 15 και 20 μετά τη γέννηση και 

τις ώρες 2, 4, 6, 8, 12 και 24 μετά τη χορήγηση της 2ης δόσης αιθανόλης την 

εκάστοτε ημέρα. Ο αριθμός των εκφυλισμένων νευρώνων αυξανόταν όσο 

περνούσαν οι ώρες με μέγιστο τις 12 και 24 ώρες μετά τη χορήγηση της 2ης δόσης 

τις ημέρες 7 και 15 μετά τη γέννηση ενώ την μέρα 20 δεν παρατηρήθηκε καθόλου 

εκφυλισμός. Επιπλέον, έγινε ανοσοϊστοχημεία για τον εντοπισμό των κασπασών 3, 

8 και 9 σε στεφανιαίες τομές εγκεφάλου τις μεταγεννητικές ημέρες 7, 15 και 20. 

Σχετικά με την κασπάση 3 βρέθηκε αύξηση στην έκφραση της την ημέρα 7 στα ζώα 

που εκτέθηκαν στην αιθανόλη σε σχέση με τα ζώα ελέγχου σε όλες τις χρονικές 

στιγμές που έγινε η παρατήρηση με μέγιστο στις 8 ώρες. Αντίστοιχα την μέρα 15 

παρατηρήθηκε αύξηση στην έκφραση της κασπάσης 3 με μέγιστο στις 8-24 ώρες, 

ενώ την μέρα 20 δεν βρέθηκε κάποια αύξηση στην έκφραση της κασπάσης 3. Η 

μελέτη για την κασπάση 9 έδειξε αύξηση της έκφρασής της από τους νευρώνες τις 

ημέρες 7 και 15, ενώ την ημέρα 20 δεν παρατηρήθηκε αύξηση. Συγκεκριμένα, την 

ημέρα 7 φάνηκε αύξηση στην έκφραση σε όλες τις χρονικές στιγμές που έγινε η 

ανάλυση με μέγιστο στις 8 και 12 ώρες και την μέρα 15 φάνηκε επίσης αύξηση όλες 

τις χρονικές στιγμές με μέγιστο στις 12 ώρες. Τέλος, έγινε ανάλυση της έκφρασης 

της κασπάσης 8 και δεν βρέθηκε καμία μεταβολή στα ζώα ελέγχου ούτε στα ζώα 
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που εκτέθηκαν στην αιθανόλη. Από τα παραπάνω μπορεί να βγει το συμπέρασμα 

ότι η αιθανόλη προκάλεσε κυτταρικό θάνατο νευρώνων στην περιοχή της κεντρικής 

αμυγδαλής μέσω του ενδογενούς μηχανισμού απόπτωσης (intrinsic apoptotic 

pathway) [9]. 

Το μεσολόβιο φαίνεται να είναι η περιοχή εκείνου του ανθρώπινου εγκεφάλου που 

επηρεάζεται περισσότερο από την προγεννητική έκθεση στην αιθανόλη. Οι πιο 

συχνές επιπτώσεις στο μεσολόβιο φαίνεται να είναι δυσμορφίες, μη ολοκληρωμένη 

ανάπτυξη και μικρότερο μέγεθος από το φυσιολογικό [10]. Παρόλα αυτά, στη 

μελέτη του Chandran και συν. (2021)  χρησιμοποιήθηκε η μαγνητική τομογραφία 

(MRI) για να γίνει σύγκριση ανάμεσα στο μεσολόβιο 28 παιδιών που η μητέρα τους 

είχε ιστορικό κατανάλωσης αιθανόλης κατά την εγκυμοσύνη και 30 παιδιών που 

αποτελούσαν την ομάδα ελέγχου και δεν βρέθηκε κάποια στατιστικά σημαντική 

διαφορά όταν ελέγχθηκε ολόκληρη η περιοχή του μεσολοβίου. Βρέθηκε όμως 

έλλειμμα στα παιδιά που εκτέθηκαν σε σχέση με την ομάδα ελέγχου όταν 

ελέγχθηκε μόνο η περιοχή στο μέσον του μεσολοβίου (midbody) [11]. Σε άλλες 

μελέτες που πάλι έγινε έλεγχος του μεσολοβίου μέσω μαγνητικής τομογραφίας 

βρέθηκαν διαφορές στο μέγεθος του μεσολοβίου στις οποίες άτομα με 

προγεννητική έκθεση στην αιθανόλη είχαν μικρότερο μέγεθος συγκριτικά με την 

ομάδα ελέγχου [12]. Σχετικά με μελέτες σε ζωικά μοντέλα επίμυων Sprague-Dawley 

η προγεννητική έκθεση στην αιθανόλη κατά το 1ο και 2ο τρίμηνο της κύησης σε 

αντιστοιχία με τον άνθρωπο φαίνεται να έχει επίδραση σε νευρώνες που 

προεκβάλλουν από το μεσολόβιο προς τον οπτικό φλοιό [13, 14]. 

 

Κυτταρικός θάνατος 

Ο κυτταρικός θάνατος είναι η διακοπή της λειτουργίας ενός κυττάρου και είναι μία 

αυστηρά προγραμματισμένη διαδικασία η οποία συμβαίνει φυσιολογικά με σκοπό 

την ομαλή λειτουργία των ιστών, των οργάνων και κατά επέκταση του οργανισμού. 

Η διαδικασία αυτή πραγματοποιείται σε μεγάλο βαθμό κατά την ανάπτυξη του 

οργανισμού και όταν για κάποιο λόγο απορρυθμίζεται μπορούν να προκύψουν 

σοβαρά προβλήματα όπως νευροεκφυλιστικές νόσοι [31]. 
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Ο κυτταρικός θάνατος ενός νευρώνα μπορεί να ενεργοποιηθεί από πολλά 

ερεθίσματα όπως (i) η διακοπή της σύνδεσης του νευρώνα αυτού με άλλους 

νευρώνες (trans neuronal degeneration), (ii) ο θάνατος των νευρώνων με τους 

οποίους συνδεόταν το κύτταρο και (iii) η καταστροφή των δενδριτών του νευρώνα 

με αποτέλεσμα την καταστροφή των συνάψεων του. Άλλα ερεθίσματα που οδηγούν 

στον θάνατο ενός νευρώνα είναι ο τραυματισμός και καταστροφή του νευράξονα 

του (axotomy), η διατάραξη της διαδικασίας του κυτταρικού κύκλου που γίνεται για 

παράδειγμα με καταστροφή του DNA λόγω οξειδωτικού στρες, η αύξηση των 

επιπέδων γλουταμινικού ή ασπαρτικού οξέως (excitotoxicity), η δημιουργία 

πρωτεϊνικών συσσωματωμάτων ή η μη σωστή αναδίπλωση πρωτεϊνών όπως το β-

αμυλοειδές στην νόσο του Alzheimer, η συσσώρευση ελεύθερων ριζών οξυγόνου 

και αζώτου (ROS, reactive oxygen species και RNS, reactive nitrogen species) και ο 

κυτταρικός θάνατος που οφείλεται στην φλεγμονή [31]. Υπάρχουν πολλοί τύποι 

κυτταρικού θανάτου και έτσι εξηγείται το ότι ένας νευρώνας μπορεί να 

καταστραφεί με 12 τουλάχιστον τρόπους. Οι βασικότεροι και πιο καλά μελετημένοι 

τύποι κυτταρικού θανάτου είναι η απόπτωση, η νέκρωση και η αυτοφαγία (εικόνα 

12) [31]. 

 

Εικόνα 12: Σχηματική απεικόνιση των πιο κοινών τύπων κυτταρικού θανάτου. Επισημαίνονται επίσης 
κάποια χαρακτηριστικά στοιχεία του κάθε τύπου. Α. Φυσιολογικό κύτταρο, Β. Απόπτωση, C. 
Αυτοφαγία, D. Νέκρωση [32]. 
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Απόπτωση 

Η απόπτωση χαρακτηρίζεται από αλλαγές στο κύτταρο που τελικά οδηγούν στη 

κατάτμησή του και στη δημιουργία μικρών κυστιδίων γνωστά ως αποπτωτικά 

σώματα. Τα αποπτωτικά σώματα στη συνέχεια απομακρύνονται με φαγοκυττάρωση 

ώστε να μην προκληθεί φλεγμονώδης αντίδραση στα υπόλοιπα κύτταρα. Η 

απόπτωση μπορεί να πραγματοποιηθεί μέσω δύο διαφορετικών μονοπατιών, το 

εξωγενές μονοπάτι (extrinsic apoptotic pathway) και το ενδογενές μονοπάτι 

(intrinsic apoptotic pathway, εικόνα 13) [31]. 

 

Εικόνα 13: Εξωγενές και ενδογενές μονοπάτι της απόπτωσης. Μπορούν να παρατηρηθούν τα στάδια 
και οι πρωτεΐνες που εμπλέκονται σε κάθε μονοπάτι καθώς και το ότι τελικά και τα δύο μονοπάτια 
οδηγούν στην ενεργοποίηση κασπασών, όπως η κασπάση 3, και στον θάνατο του κυττάρου [31]. 

 

Το εξωγενές μονοπάτι ξεκινά με την πρόσδεση του παράγοντα TNF (tumor necrosis 

factor) σε ειδικό υποδοχέα της μεμβράνης του κυττάρου που τελικά έχει ως 

αποτέλεσμα την προτεόλυση της προ-κασπάσης 8 στην ενεργή της μορφή κασπάση 

8 . Η κασπάση 8 ενεργοποιεί άλλες κασπάσες, όπως η κασπάση 3, με προτεόλυση 

(άμεσος τρόπος) ή μέσω προτεόλυσης και ενεργοποίησης άλλων παραγόντων που 
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τελικά θα οδηγήσουν στην ενεργοποίηση κασπασών (έμμεσος τρόπος) με τελικό 

αποτέλεσμα τον κυτταρικό θάνατο [31]. 

Το ενδογενές μονοπάτι ενεργοποιείται από σήματα μέσα στο κύτταρο και μέσω 

αυτών πραγματοποιείται έκφραση και ενεργοποίηση πρωτεϊνών που τελικά 

δημιουργούν πόρους στην εξωτερική μιτοχονδριακή μεμβράνη (π.χ. πρωτεΐνες Bax). 

Η ενεργοποίηση των πρωτεϊνών αυτών αναστέλλει το σύμπλοκο ΙΙ της 

αναπνευστικής αλυσίδας στα μιτοχόνδρια με αποτέλεσμα να παράγονται ROS οι 

οποίες ενεργοποιούν μονοπάτια που προκαλούν αναδιαμόρφωση της εσωτερικής 

μιτοχονδριακής μεμβράνης (Εικόνα 14). Μέσω των πόρων που δημιουργούνται 

στην εξωτερική πυρηνική μεμβράνη απελευθερώνεται το κυτόχρωμα c στο 

κυτταρόπλασμα και το τελικό αποτέλεσμα είναι αρχικά, η μετατροπή της προ-

κασπάσης 9 στην ενεργή της μορφή και στη συνέχεια, η πρωτεολυτική 

ενεργοποίηση και άλλων κασπασών από την κασπάση 9 που τελικά θα οδηγήσουν 

στον θάνατο του κυττάρου [31]. 

 

Εικόνα 14: Η παραγωγή ROS που προκαλείται από τις πρωτεΐνες Bax έχει ως αποτέλεσμα την 
ενεργοποίηση κι άλλων πρωτεϊνών, όπως OMA-1 και OPA-1, που οδηγούν τελικά στην 
αναδιαμόρφωση της εσωτερικής μιτοχονδριακής μεμβράνης και στην αύξηση της απελευθέρωσης 
του κυττοχρώματος c στο κυτταρόπλασμα, το οποίο τελικά προκαλεί την απόπτωση [31].  
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Νέκρωση 

Η νέκρωση είναι ο τύπος του κυτταρικού θανάτου κατά τον οποίο η μεμβράνη του 

κυττάρου καταστρέφεται και τα κυτταρικά συστατικά απελευθερώνονται 

προκαλώντας συνήθως φλεγμονή. Θεωρείται ότι υπάρχουν δύο τύποι νέκρωσης, η 

ρυθμιζόμενη νέκρωση η οποία φαίνεται να γίνεται με ελεγχόμενο τρόπο που είναι 

καταγεγραμμένος στο γενετικό υλικό του κυττάρου και η μη ρυθμιζόμενη νέκρωση 

η οποία δεν έχει κάποιο γενετικό υπόβαθρο και είναι συνέπεια κάποιου 

τραυματισμού ή τοξίνης στην οποία εκτέθηκε το κύτταρο. Η διάκριση αυτή όμως σε 

ρυθμιζόμενη και μη ρυθμιζόμενη νέκρωση δεν έχει καθοριστεί πλήρως και δεν είναι 

πάντα εύκολο να γίνει [31]. 

Υπάρχουν πολλές κατηγορίες ρυθμιζόμενης νέκρωσης: 

(i) η νεκρόπτωση που βασίζεται στη δραστηριότητα της κινάσης RIP1 

(Receptor Interacting Kinase 1), 

(ii) ο παρθάνατος που γίνεται με δράση της πολυμεράσης PARP (Poly ADP-

Ribose Polymerase), 

(iii) η φερρόπτωση που είναι σιδηροεξαρτώμενος τύπος ρυθμιζόμενης 

νέκρωσης,  

(iv) ο κυτταρικός θάνατος που οφείλεται στη μεταβολή της διαπερατότητας 

της εσωτερικής μιτοχονδριακής μεμβράνης εξαιτίας του ανοίγματος του 

πόρου mPTP (permeability transition pore), 

(v) η αυτόλυση που οφείλεται στην αύξηση της διαπερατότητας της 

λυσοσωμικής μεμβράνης και την απελευθέρωση των συστατικών των 

λυσοσωμάτων στο κυτταρόπλασμα και 

(vi) η πυρόπτωση που εξαρτάται από τη δραστηριότητα της κασπάσης 1. 

Η νεκρόπτωση αποτελεί την πιο καλά χαρακτηρισμένη μορφή ρυθμιζόμενης 

νέκρωσης (εικόνα 15). Κατά την νεκρόπτωση αρχικά γίνεται φωσφορυλίωση της 

κινάσης RIP1 η οποία στη συνέχεια φωσφορυλιώνει την κινάση RIP3 και με τη σειρά 

της φωσφορυλιώνει την ψευδοκινάση MLKL (Mixed Lineage Kinase Domain-like). 

Έπειτα δημιουργείται το νεκρόσωμα, που είναι σύμπλοκο των τριών αυτών 

κινασών, και προκαλείται ολιγομερισμός και συγκέντρωση πολλών MLKL στην 
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κυτταρική μεμβράνη, κάτι που οδηγεί στην καταστροφή της μεμβράνης και τη 

νέκρωση [31]. 

 

Εικόνα 15: Στάδια κατά τα οποία πραγματοποιείται η νεκρόπτωση. Η νεκρόπτωση συμβαίνει μόνο 
όταν η κασπάση 8 είναι ανενεργή καθώς όταν είναι ενεργή απενεργοποιεί το σύμπλοκο της κινάσης 
RIP1 με την RIP3 [31]. 

 

Αυτοφαγία  

Η αυτοφαγία είναι μία καλά ρυθμιζόμενη διαδικασία κατά την οποία τα συστατικά 

του κυττάρου καταστρέφονται στο λυσόσωμα και ξαναδημιουργούνται (εικόνα 16). 

Τα συστατικά του κυττάρου που πρόκειται να καταστραφούν κλείνονται σε ειδικά 

κυστίδια και δημιουργούν το αυτοφαγόσωμα, το οποίο στη συνέχεια συντήκεται με 

το λυσόσωμα και καταστρέφεται εξαιτίας της δράσης των λυσοσωμικών ενζύμων. Η 

αυτοφαγία είναι μία διαδικασία που προάγει την κυτταρική επιβίωση καθώς 

συμβαίνει για ανακύκλωση και ανανέωση των συστατικών του κυττάρου και σε 

κάποιες περιπτώσεις βοηθάει στην καταστροφή παθογόνων που εισβάλλουν στο 

κύτταρο. Όμως, όταν η διεργασία της αυτοφαγίας απορρυθμίζεται και 

πραγματοποιείται σε υπερβολικό βαθμό τότε προκαλείται κυτταρικός θάνατος [31]. 
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Εικόνα 16: Διαδικασία της αυτοφαγίας. Στην εικόνα φαίνεται ο σχηματισμός του αυτοφαγοσώματος 

από κυστίδια που περικλείουν τα κυτταρικά συστατικά και η σύντηξή του με το λυσόσωμα. Επίσης, 

φαίνονται οι παράγοντες που εμπλέκονται σε κάθε στάδιο σχηματισμού του αυτοφαγοσώματος. Η 

διαδικασία της αυτοφαγίας εμπλέκεται και με αυτή της απόπτωσης καθώς φαίνεται ότι παράγοντες, 

όπως η Bcl2, συμμετέχουν και στις δύο περιπτώσεις [31].   



- 28 - 
 

Σκοπός 

 

Δεδομένης της αύξησης του ποσοστού κατανάλωσης αιθανόλης από κυοφορούσες 

γυναίκες τα τελευταία χρόνια, όπως αναφέρθηκε, αναμένεται και αύξηση των 

περιπτώσεων FAS τα επόμενα χρόνια. Καθίσταται λοιπόν αναγκαία η περαιτέρω 

μελέτη του FAS ώστε να εξακριβωθούν σε μεγαλύτερο βαθμό οι μηχανισμοί με τους 

οποίους η προγεννητική έκθεση στην αιθανόλη προκαλεί δυσμενείς συνέπειες στην 

εμβρυϊκή ανάπτυξη με σκοπό την εύρεση αποτελεσματικών τρόπων αντιμετώπισης 

του συνδρόμου αυτού αλλά και καλύτερης κατανόησης της τοξικής δράσης της 

αιθανόλης. 

Η παρούσα πτυχιακή εργασία εξετάζει την μακροχρόνια επίδραση που έχει η 

αιθανόλη στον εγκεφάλο ενήλικων επίμυων Sprague-Dawley σε ζωικό μοντέλο 

εμβρυικού αλκοολικού συνδρόμου. Στο συγκεκριμένο μοντέλο τα ζώα εκτέθηκαν 

κατά την εμβρυϊκή τους ανάπτυξη και τις πρώτες μέρες μετά τη γέννησή τους σε 

αιθανόλη έτσι ώστε ο συνολικός χρόνος έκθεσης τους στην αλκοόλη να αντιστοιχεί 

σε όλη τη διάρκεια της ανθρώπινης κύησης. Δόθηκε έμφαση στον κυτταρικό θάνατο 

που πιθανά προκαλεί η εμβρυική έκθεση στην αιθανόλη στον προμετωπιαίο φλοιό, 

το ραχιαίο ραβδωτό σώμα, τον επικλινή πυρήνα, την κεντρική αμυγδαλή και το 

μεσολόβιο. 
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Μέθοδολογία 

Πειραματόζωα 

Για τη διεξαγωγή των πειραμάτων χρησιμοποιήθηκαν επίμυες στελέχους Sprague-

Dawley οι οποίοι προήλθαν από το τμήμα Βιολογικών Εφαρμογών και Τεχνολογιών 

του Πανεπιστημίου Ιωαννίνων. Οι επίμυες διαβιούσαν σε πλαστικούς κλωβούς με 

μέγιστο 3 σε κάθε κλωβό και ο διαχωρισμός των απογόνων από την μητέρα έγινε 24 

μέρες μετά τη γέννηση. Σε κάθε κλωβό υπήρχαν μόνο αρσενικοί ή μόνο θηλυκοί 

επίμυες και είχαν πρόσβαση σε άφθονο νερό και τροφή. Οι συνθήκες διαβίωσης 

διατηρούνταν σταθερές με τη θερμοκρασία να είναι στους 21±2 οC και ο κύκλος 

φωτός/σκότους να είναι 12 ώρες φωτός (από 8π.μ. μέχρι 8μ.μ) και 12 ώρες σκότους 

(από 8μ.μ έως 8π.μ.). Ο τρόπος διαβίωσης των πειραματόζωων όπως και όλοι οι 

πειραματικοί χειρισμοί έγιναν σύμφωνα με τις οδηγίες του Ευρωπαϊκού 

Κοινοβουλίου και του Συμβουλίου 22ας Σεπτεμβρίου 2010 περί προστασίας ζώων 

που χρησιμοποιούνται για επιστημονικούς σκοπούς (2010/63/ΕΕ). Σε όλη τη 

διάρκεια της διεξαγωγής των πειραμάτων κατεβλήθη η μέγιστη δυνατή προσπάθεια 

για την ελαχιστοποίηση της ταλαιπωρίας και του αριθμού των ζώων που 

χρησιμοποιήθηκαν. 

Για την παρούσα εργασία χρησιμοποιήθηκαν συνολικά 15 επίμυες από τους 

οποίους οι 8 αποτελούν τις ομάδες ελέγχου όπου 4 επίμυες ανήκουν στην ομάδα 

ελέγχου που θυσιάστηκαν στους 2 μήνες (55 μέρες) μετά τη γέννηση και 4 επίμυες 

ανήκουν στην ομάδα ελέγχου και θυσιάστηκαν στους 3,5 μήνες [95(1), 96(1), 100(2) 

μέρες] μετά τη γέννηση. Οι υπόλοιποι 7 επίμυες αποτελούν την ομάδα που 

εκτέθηκε στην αιθανόλη (συνθήκη FAS) με 4 να θυσιάστηκαν στους 2 μήνες [56(2), 

57(1), 58(1) μέρες] μετά τη γέννηση ενώ οι υπόλοιποι 3 θυσιάστηκαν στους 3,5 

μήνες [97(2), 99(1) μέρες] μετά τη γέννηση. Επομένως, υπάρχουν 4 διαφορετικές 

συνθήκες οι οποίες είναι Α. Ομάδα ελέγχου 2 μηνών (4 επίμυες), Β. Ομάδα ελέγχου 

3,5 μηνών (4 επίμυες), Γ. Ομάδα FAS 2 μηνών (4 επίμυες), Δ. Ομάδα FAS 3,5 μηνών 

(3 επίμυες). 
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Πρωτόκολλο έκθεσης στην αιθανόλη 

Σε θηλυκούς Sprague-Dawley επίμυες τοποθετήθηκε διάλυμα αιθανόλης ως μόνη 

πηγή νερού για 2 εβδομάδες με 10% v/v συγκέντρωση την 1η εβδομάδα και 15% v/v 

συγκέντρωση την 2η εβδομάδα. Από την 3η εβδομάδα ξεκίνησε η αναπαραγωγή και 

κύηση ενώ συνεχίστηκε ως πηγή νερού να είναι διάλυμα αιθανόλης 15% v/v μέχρι 

και μία εβδομάδα μετά την γέννηση. Τη 2η εβδομάδα μετά τη γέννηση η 

συγκέντρωση της αιθανόλης μειώθηκε στο 10% v/v ενώ στην αρχή της 3ης 

εβδομάδας και μετά η συγκέντρωση μηδενίστηκε και τοποθετήθηκε νερό βρύσης 

(εικόνα 17). 

 

Εικόνα 17: Διαδικασία δημιουργίας επίμυων με εμβρυϊκό αλκοολικό σύνδρομο. PND: Postnatal Day 

 

 

Ενδοκαρδιακή μονιμοποίηση ιστών 

Αναισθησίες 

Πριν τη διαδικασία της ενδοκαρδιακής μονιμοποίησης έγινε αναισθησία των 

επίμυων. Ο επίμυς τοποθετήθηκε αρχικά σε γυάλινο δοχείο στο οποίο 

τοποθετήθηκε βαμβάκι εμποτισμένο με διαιθυλαιθέρα ώστε να προκληθεί ζάλη και 

να είναι πιο εύκολοι οι χειρισμοί. Έπειτα, για την αναισθητοποίηση χορηγήθηκαν 

ενδοπεριτοναϊκά 2ml προποφόλης και ενδομυϊκά στον μηρό 200μL κεταμίνης και η 

διαπίστωση της αναισθησίας έγινε με την μη απόσυρση του ποδιού όταν 

εφαρμόστηκε σε αυτό ένα ερέθισμα πόνου. Στη συνέχεια, ο επίμυς ζυγίστηκε και 

τοποθετήθηκε σε απαγωγό για να ξεκινήσει η διαδικασία της ενδοκαρδιακής 

μονιμοποίησης. Τα παραπάνω ισχύουν για τους επίμυες της ομάδας ελέγχου 2 

μηνών, της ομάδας FAS 2 μηνών και της ομάδας FAS 3,5 μηνών. Για τους επίμυες 
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της ομάδας ελέγχου 3,5 μηνών υπήρξε μία διαφοροποίηση. Το ζύγισμα 

πραγματοποιήθηκε αμέσως μόλις προκλήθηκε ζάλη από τον διαιθυλαιθέρα και με 

βάση το βάρος προσδιορίστηκε η ποσότητα αναισθητικού του παρασκευάσματος 

Zoletil που χορηγήθηκε (εικόνα 18). Το παρασκεύασμα αυτό περιέχει την ουσία 

τιλεταμίνη που είναι ανάλογο της κεταμίνης και θεωρείται πιο δραστική από αυτήν 

καθώς και ζολαζεπάμη που είναι μία βενζοδιαζεπίνη [41]. Χορηγήθηκε ποσότητα σε 

ml ίση με το 1/1000 του βάρους σε gr κάθε επίμυ. Η χορήγηση έγινε ενδομυϊκά στην 

μηρό σε μία δόση. 

 

Εικόνα 18: Το φαρμακευτικό παρασκεύασμα Zoletil που χρησιμοποιήθηκε ως αναισθητικό [41]. 

 

Πρωτόκολλο μονιμοποίησης 

Με την έναρξη της διαδικασίας ο επίμυς τοποθετήθηκε ανάσκελα στον απαγωγό 

και έγινε τομή στο ύψος της ξιφοειδούς απόφυσης. Έπειτα, έγιναν τομές προς τον 

θώρακα και από τις δύο πλευρές μέχρι να εμφανιστεί η καρδιά. Στη συνέχεια, 

τοποθετήθηκε στην αριστερή κοιλία της καρδιάς ειδική βελόνα η οποία συνδεόταν 

με αντλία μέσω ειδικού σωληναρίου και με ενεργοποίηση της αντλίας στις 48 

στροφές ξεκίνησε η παροχή ορού (διάλυμα 0,9% NaCl). Παράλληλα έγινε μία τομή 

στον δεξιό κόλπο της καρδιάς για την έξοδο του ορού και του αίματος (Εικόνα 19).  
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Εικόνα 19: Προετοιμασία του πειραματόζωου για την έναρξη της διαδικασίας ενδοκαρδιακής 
μονιμοποίησης. [34] 

 

Η παροχή ορού συνεχίστηκε μέχρι την απομάκρυνση όσο περισσότερου αίματος 

είναι δυνατό, κάτι που μπορεί να διαπιστωθεί με το λευκό χρώμα των πνευμόνων, 

των ματιών και την παρατήρηση εξόδου μόνο ορού από τη δεξιά κοιλία, καθώς σε 

περίπτωση παραμονής αίματος στον εγκέφαλο μπορεί να προκύψουν εσφαλμένα 

αποτελέσματα κατά τη διαδικασία της ανοσοϊστοχημείας λόγω της πρόσδεσης των 

αντισωμάτων στα ερυθρά αιμοσφαίρια. Μετά τον ορό χορηγήθηκε με τον ίδιο 

τρόπο 0.1Μ PB (Phosfate Buffer) διάλυμα 4% παραφορμαλδεϋδης (PFA) το οποίο 

είναι μονιμοποιητικό ιστών. Αφού ολοκληρώθηκε η μονιμοποίηση το πειραματόζωο 

τοποθετήθηκε σε κατάλληλη θέση με σκοπό την απομόνωση του εγκεφάλου. 

Αρχικά, απομακρύνθηκε το δέρμα για την εμφάνιση του κρανίου και ακολούθησε 

διάνοιξη του κρανίου με οστεοκόπτη (Εικόνα 20). Η απομόνωση του εγκεφάλου 

πραγματοποιήθηκε με τη βοήθεια σπάτουλας αφού προηγήθηκε η απελευθέρωσή 

του από τις μήνιγγές που τον περιβάλλουν για την αποφυγή του τραυματισμού του. 

 

 

Εικόνα 20: Στάδια με σκοπό την απομόνωση του εγκεφάλου από τον επίμυ. [34] 
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Στη συνέχεια, ο εγκέφαλος τοποθετήθηκε σε πλαστικό σωλήνα τύπου Falcon με 

βιδωτό πώμα ο οποίος περιείχε ποσότητα διαλύματος 0.1Μ PB 4% 

παραφορμαλδεϋδης και έμεινε εκεί για όλη τη νύχτα (overnight) σε ψυχρό θάλαμο 

4οC. Την επόμενη μέρα το διάλυμα στον σωλήνα αντικαταστάθηκε με διάλυμα 30% 

σουκρόζης για τον σκοπό της κρυοπροστασίας μέσα στο οποίο ο εγκέφαλος 

παραμένει μέχρι να καταβυθιστεί, κάτι που συμβαίνει σε χρονικό διάστημα 

περίπου 48 ωρών. Ουσιαστικά η σουκρόζη λόγω διαφοράς ωσμωτικής πίεσης 

αντικαθιστά το νερό που υπάρχει στα κύτταρα του εγκεφάλου και έτσι τον 

προστατεύει από διόγκωση και καταστροφή σε χαμηλές θερμοκρασίες. Η είσοδος 

της σουκρόζης στα κύτταρα του εγκεφάλου προσδίδει βάρος σε αυτόν και τελικά 

καταβυθίζεται. Στη συνέχεια ο εγκέφαλος τοποθετήθηκε σε ποτήρι ζέσεως που 

περιείχε ισοπεντάνιο θερμοκρασίας -45οC για 1 λεπτό με σκοπό την ταχεία ψύξη 

του και έπειτα διατηρήθηκε σε θερμοκρασία -80οC μέχρι τη στιγμή της μετέπειτα 

επεξεργασίας του που είναι η τομή του σε κρυοτόμο. 

 

Διαμερισμός του εγκεφάλου με χρήση κρυοτόμου 

Ζελατινοποίηση αντικειμενοφόρων πλακών 

Για τη συλλογή των τομών εγκεφάλου από την κρυοτόμο χρησιμοποιήθηκαν 

ζελατινοποιημένες αντικειμενοφόρες πλάκες. Η ζελατινοποίησή τους έγινε με 

εμβάπτιση των πλακών σε διάλυμα ζελατίνης το οποίο περιείχε και ποσότητα 

δωδεκάυδρου θειικού χρωμιούχου καλίου [CrK(SO4)2 - 12H2O] που φορτίζει θετικά 

τις πλάκες ώστε να μπορούν πιο εύκολα να προσκολληθούν σε αυτές οι αρνητικά 

φορτισμένες τομές εγκεφάλου. Μετά την εμβάπτιση οι πλάκες αφέθηκαν να 

στεγνώσουν και έπειτα αποθηκεύτηκαν στα κουτιά από τα οποία προήλθαν μέχρι 

τη χρήση τους (Εικόνα 21). 
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Εικόνα 21: Σχηματική αναπαράσταση της διαδικασίας που ακολουθήθηκε για την ζελατινοποίηση 
των αντικειμενοφόρων πλακών. 

 

Στεφανιαίες τομές εγκεφάλου και διατήρησή τους 

Με χρήση της κρυοτόμου Leica CM1850 οι εγκέφαλοι κόπηκαν σε στεφανιαίες 

τομές πάχους 10μm και συλλέχθηκαν σε ζελατινοποιημένες αντικειμενοφόρες 

πλάκες. Η κρυοτόμος ρυθμίστηκε στη θερμοκρασία -20οC και οι εγκέφαλοι 

προσκολλήθηκαν σε ειδική βάση με τη βοήθεια OCT (Optimal Cutting Temperature 

compound) που είναι ένα ρευστό υλικό και στερεοποιείται σε χαμηλές 

θερμοκρασίες. Οι αντικειμενοφόρες πλάκες στις οποίες συλλέχθηκαν οι τομές 

φυλάχθηκαν σε θερμοκρασία -20οC μέχρι την περαιτέρω επεξεργασία τους. 
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Σήμανση σωματιδίων Nissl 

Τα σωματίδια Nissl εμφανίζονται με μορφή κόκκων και βρίσκονται στο 

κυτταρόπλασμα των νευρικών κυττάρων στην περιοχή του κυτταρικού σώματος ενώ 

μπορεί να παρατηρηθούν και σε δενδρίτες. Τα σωματίδια αυτά αποτελούνται από 

ένα σύνολο πολυσωμάτων (συμπλέγματα ριβοσωμάτων με mRNA) και αδρό 

ενδοπλασματικό δίκτυο ενώ ο ρόλος τους είναι η πρωτεϊνοσύνθεση [42]. Η 

ιστολογική βασική χρωστική Cresyl violet μπορεί να χρωματίσει τα σωματίδια Nissl 

και να διευκολύνει την παρατήρηση νευρώνων στο οπτικό μικροσκόπιο. 

 

Χρώση  Cresyl Violet 

Οι αντικειμενοφόρες πλάκες αφαιρέθηκαν από τα κουτιά τους στα οποία 

φυλάσσονταν στην κατάψυξη (-20οC) και τοποθετήθηκαν σε ειδικά πλαστικά racks. 

Στη συνέχεια, τα racks με τις πλάκες τοποθετήθηκαν για 10 λεπτά σε πλαστικό 

δοχείο με διάλυμα Αιθανόλης-Χλωροφορμίου-Οξικού οξέος με σκοπό τον 

καθαρισμό των τομών. Ακολούθησε ενυδάτωση για 3 λεπτά και έπειτα βύθιση σε 

δοχείο με διάλυμα χρωστικής Cresyl violet-οξικού νατρίου που είχε pH 4.5 για 5 

λεπτά. Μετά από άλλη μία ενυδάτωση για 2 λεπτά τα racks τοποθετήθηκαν σε 

δοχεία με διαδοχικές συγκεντρώσεις αιθανόλης (50%, 75%, 95%, 100%) για 5 

δευτερόλεπτα κάθε φορά με σκοπό την αφυδάτωση των ιστών και τέλος σε δοχείο 

με ξυλένιο όπου και παρέμειναν εκεί μέχρι την τοποθέτηση καλυπτρίδων. 

Οι τομές πάνω στις πλάκες καλύφθηκαν με καστορέλαιο και από πάνω 

τοποθετήθηκε ειδική καλυπτρίδα. Για το σφράγισμα της καλυπτρίδας πάνω στην 

πλάκα τοποθετήθηκε βερνίκι για νύχια περιφερικά της καλυπτρίδας. Αφού το 

βερνίκι στέγνωσε οι πλάκες ήταν έτοιμες για παρατήρηση στο στερεοσκόπιο και 

φωτογράφιση των τομών. Το στερεοσκόπιο ήταν το KERN OZL 463 και η κάμερα με 

την οποία τραβήχτηκαν οι φωτογραφίες ήταν η KERN ODC 832. 

 

Ανάλυση εικόνας 

Η ανάλυση των φωτογραφιών έγινε με τη χρήση του προγράμματος ImageJ και 

πραγματοποιήθηκε μέτρηση έντασης σήματος και απόστασης (πάχος στιβάδας). 
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Για τον σκοπό της μέτρησης της έντασης σήματος αρχικά ορίζονται οι ρυθμίσεις με 

άνοιγμα του παραθύρου του Set Measurements (Analyze>Set Measurements) και 

ενεργοποίηση των επιλογών R Area, R Mean grey value, R Standard deviation, R 

Mean & max grey value, R Display Label και R Add to overlay. Έπειτα ενεργοποιείται 

ο Διαχειριστής των Περιοχών Ενδιαφέροντος (ROI Manager
 
: Analyze>Tools>ROI 

Manager) και επιλέγεται η επιθυμητή προς μέτρηση περιοχή με τη βοήθεια του 

Εργαλείου Πολυγωνικής Επιλογής (Polygonal selection) πάνω στη φωτογραφία. Η 

περιοχή μπορεί να ονομαστεί με τη συντόμευση Ctrl+y στο πληκτρολόγιο και να 

προστεθεί στο ROI Manager με τη συντόμευση Ctrl+t. Η φωτογραφία μπορεί να 

αποθηκευτεί ως tiff μέσω της επιλογής File>Save As αφού προηγηθεί η επιλογή 

Image>Overlay>From ROI Manager ώστε να φαίνεται η περιοχή ή περιοχές που 

πραγματοποιήθηκαν οι μετρήσεις. Έτσι δημιουργείται ένα πρόσθετο επίπεδο το 

περιεχόμενο του οποίου μπορεί να μεταφερθεί στο ROI Manager με την επιλογή 

Image>Overlay>To ROI Manager την επόμενη φορά που θα ανοίξει η φωτογραφία. 

Ο πίνακας αποτελεσμάτων από το ROI Manager μεταφέρθηκε στο πρόγραμμα Excel.  

Για το σκοπό της μέτρησης της απόστασης (πάχος στιβάδας) αρχικά σβήνονται όλες 

οι επιλογές στο Set Measurements (Analyze>Set Measurements) εκτός από τις R 

Display Label και R Add to overlay. Στη συνέχεια ενεργοποιείται ο Διαχειριστής των 

Περιοχών Ενδιαφέροντος (ROI Manager: Analyze>Tools>ROI Manager) και 

επιλέγεται η περιοχή (πάχος στιβάδας) προς μέτρηση με το Εργαλείο Ευθείας 

Γραμμής (Straight). Η περιοχή μπορεί να ονομαστεί πατώντας Ctrl+y στο 

πληκτρολόγιο και να προστεθεί στο ROI Manager με τη συντόμευση Ctrl+t όπως 

αναφέρθηκε και παραπάνω. Η φωτογραφία αποθηκεύεται ως tiff πατώντας 

File>Save As αφού προηγηθεί η επιλογή Image>Overlay>From ROI Manager για να 

δημιουργηθεί το πρόσθετο επίπεδο. Την επόμενη φορά που θα ανοίξει η 

φωτογραφία το περιεχόμενο του πρόσθετου επιπέδου μπορεί να μεταφερθεί στο 

ROI Manager με την επιλογή Image>Overlay>To ROI Manager. Ο πίνακας 

αποτελεσμάτων από το ROI Manager μεταφέρθηκε στο πρόγραμμα Excel. 
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Για να γίνει η αντιστοίχιση του αριθμού των εικονοστοιχείων (pixels) που μετρώνται 

με μονάδα μήκους (μm) γίνεται προσθήκη κλίμακας (scale bar) στις φωτογραφίες. 

Για τον σκοπό αυτό αρχικά φωτογραφίζεται η κλίμακα στο μικροσκόπιο και στο 

φακό που έχουν τραβηχτεί οι φωτογραφίες που αναλύθηκαν και τοποθετείται μια 

ευθεία γραμμή με το Εργαλείο Ευθείας Γραμμής (Straight) πάνω στην κλίμακα στο 

πρόγραμμα ImageJ. Το αποτέλεσμα της μέτρησης μεταφέρεται στο παράθυρο 

Ορισμού Κλίμακας (Set Scale) με την επιλογή Analyze>Set Scale και συμπληρώνονται 

και τα στοιχεία απόσταση που μετρήθηκε (Known distance) και μονάδα μέτρησης 

μήκους (Unit of length). Με αυτό τον τρόπο φαίνεται η αντιστοιχία ανάμεσα στα 

εικονοστοιχεία (pixels) και τα μm. 

 

Μέτρηση πάχους μεσολοβίου  

Το πάχος του μεσολοβίου στο επίπεδο ιπποκάμπου δεν είναι σταθερό σε όλη την 

έκταση του στις στεφανιαίες τομές εγκεφάλου φυσιολογικού επίμυος. 

Συγκεκριμένα, σύμφωνα με τον άτλαντα των Paxinos & Watson [40] το πάχος του 

μεσολοβίου φαίνεται να είναι σταθερό στις περιοχές από Βρέγμα -1,80 μέχρι -2,04, 

από Βρέγμα -2,16 μέχρι -2,92, από Βρέγμα -3,00 μέχρι -3,72 και από Βρέγμα -3,84 

μέχρι -4,80 (Εικόνα 22). 
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Εικόνα 22: Οι περιοχές του εγκεφάλου που χρησιμοποιήθηκαν για τη μέτρηση του πάχους του 
μεσολοβίου στο επίπεδο του ραχιαίου ιπποκάμπου σύμφωνα με τον άτλαντα των Paxinos & Watson 
[40]. 

 

 

 

Ανοσοϊστοχημεία 

Πρωτόκολλο ανοσοϊστοχημείας 

Η διαδικασία της ανοσοϊστοχημείας διεξάγεται σε 2 μέρες. 

Την 1η μέρα επιλέγονται οι πλάκες με τις τομές και παραμένουν σε θερμοκρασία 

δωματίου για 30 λεπτά ώστε να ξεπαγώσουν. Ακολουθούν δύο πλύσεις των 10 

λεπτών η κάθε μία με διάλυμα 0,1Μ TBS (Tris Buffer Saline) pH 7,4 και στη συνέχεια 
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επώαση για 30 λεπτά με διάλυμα 3,3% NS (Normal Serum) κατσίκας σε 0,1Μ TBS. Το 

2ο αντίσωμα που χρησιμοποιήθηκε προήλθε από κατσίκα και αυτός είναι ο λόγος 

που χρησιμοποιήθηκε ορός κατσίκας. Ο σκοπός της επώασης αυτής είναι η 

κατάληψη μη ειδικών θέσεων του 2ου αντισώματος για την αποφυγή σφαλμάτων 

(blocking). Έπειτα πραγματοποιήθηκαν τρείς πλύσεις 5 λεπτών η καθεμία με 

διάλυμα 0,1Μ TBS και ακολούθησε επώαση για όλη τη νύχτα (συγκεκριμένα 16-18 

ώρες) με διάλυμα που περιείχε το 1ο αντίσωμα. Το διάλυμα αυτό λέγεται Ab-1 και 

εκτός από το 1ο αντίσωμα είχε σύσταση 0,5% v/v NS κατσίκας, 0,3%v/v Triton X-100 

διαλυμένα σε 0,1Μ TBS. To Triton X-100 είναι ένα απορρυπαντικό και 

χρησιμοποιείται ώστε να δημιουργηθούν οπές στη μεμβράνη των κυττάρων ώστε 

να τη διαπερνά εύκολα το αντίσωμα. Το 1ο αντίσωμα (Rabbit H9BN 140) που 

χρησιμοποιήθηκε προήλθε από κουνέλι, στοχεύει τον παράγοντα NeuN (Neuronal 

Nuclear Protein) και ήταν σε συγκέντρωση 1/400. Ο παράγοντας NeuN εκφράζεται 

μόνο σε νευρικά κύτταρα και δεν έχει ανιχνευτεί σε άλλα σωματικά κύτταρα ή 

κύτταρα γλοίας, για αυτό και χρησιμοποιείται συχνά ως δείκτης νευρικών 

κυττάρων. Η λειτουργία του παράγοντα αυτού δεν έχει καθοριστεί πλήρως ενώ 

είναι γνωστό ότι βρίσκεται σε περιοχές που υπάρχει μικρή πυκνότητα χρωματίνης 

και έχει την ικανότητα να προσδένεται στο DNA. Γνωστό είναι επίσης ότι η 

λειτουργία του σχετίζεται με το εναλλακτικό μάτισμα στα νευρικά κύτταρα. [35] 

Την 2η μέρα αρχικά πραγματοποιούνται τρεις πλύσεις 5 λεπτών η καθεμία στις 

πλάκες με διάλυμα 0,1Μ TBS και στη συνέχεια γίνεται επώαση για 1,5 ώρα με το 

διάλυμα του 2ου αντισώματος. Όλες οι διεργασίες με το 2ο αντίσωμα 

πραγματοποιούνται στο σκοτάδι για να μην εξασθενήσει η ικανότητα του να 

φθορίζει. Το 2o αντίσωμα που χρησιμοποιήθηκε (Alexa Fluor 594 goat anti-rabbit) 

προήλθε από κατσίκα και στόχευε το 1ο αντίσωμα που χρησιμοποιήθηκε την 1η 

μέρα ενώ ήταν σε συγκέντρωση 1/500. Μετά την επώαση ακολούθησαν τρεις 

πλύσεις των 5 λεπτών η καθεμία και τέλος οι τομές στις πλάκες καλύφθηκαν με 

mounting medium που περιείχε DAPI (4′,6-diamidino-2-phenylindole) ως μέσo 

παρατήρησης στο μικροσκόπιο. Το DAPI είναι μία φθορίζουσα χρωστική η οποία 

προσδένεται σε περιοχές στο DNA πλούσιες στα νουκλεοτίδια με βάσεις αδενίνη 

και θυμίνη και έτσι χρησιμοποιείται για τη σήμανση πυρήνων. Στις πλάκες πάνω 
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από το mounting medium τοποθετήθηκαν καλυπτρίδες και μετά από σφράγισμα με 

βερνίκι για νύχια αποθηκεύτηκαν σε ψυχρό θάλαμο (4οC) μέχρι την παρατήρηση 

στο μικροσκόπιο φθορισμού. Το μικροσκόπιο φθορισμού που χρησιμοποιήθηκε για 

παρατήρηση και φωτογράφιση των τομών ήταν το Zeiss Axio Imager Z2 και η 

κάμερα με την οποία φωτογραφήθηκαν οι τομές ήταν η Zeiss Axiocam ICc 5. 

 

Ανάλυση εικόνας 

Η ανάλυση των φωτογραφιών έγινε με τη βοήθεια του προγράμματος ImageJ και 

μετρήθηκε ο αριθμός όλων των κυττάρων (χρώση με DAPI) και ξεχωριστά ο αριθμός 

μόνο των νευρώνων (αντίσωμα που στοχεύει τον παράγοντα NeuN). Για να συμβεί 

αυτό αρχικά ανοίχθηκαν οι δύο φωτογραφίες στο πρόγραμμα ImageJ (οι δύο 

φωτογραφίες είναι ακριβώς ίδιες και αντιστοιχούν στην ίδια τομή απλά η μία 

δείχνει τη χρώση από το DAPI και η άλλη τον φθορισμό από το αντίσωμα ενάντια 

του NeuN) και επιλέχθηκε η επιθυμητή προς μέτρηση περιοχή με το Εργαλείο 

Ορθογώνιας Επιλογής (Rectangular Selection). Η περιοχή επιλέχθηκε έτσι ώστε να 

είναι όσο το δυνατόν πιο εμφανή και διακριτά τα κύτταρα και προστέθηκε στο ROI 

Manager με την επιλογή Ctrl+t όπου και μετρήθηκε η επιφάνεια της (τιμή στην 

περιοχή Area στο ROI Manager). Στη συνέχεια μέσω της επιλογής Process>Find 

Maxima και προσαρμογής της τιμής Prominence για να ανιχνεύονται σωστά όλα τα 

κύτταρα ολοκληρώθηκε η μέτρηση των κυττάρων στην περιοχή που επιλέχθηκε 

αρχικά στη φωτογραφία με τη χρώση DAPI και έπειτα στη φωτογραφία με τη 

σήμανση του NeuN. Τα αποτελέσματα μεταφέρθηκαν στο πρόγραμμα excel για 

περεταίρω επεξεργασία.  
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Ανοσοαποτύπωσης κηλίδας  

Απομόνωση εγκεφαλικών περιοχών 

Για την απομόνωση του εγκεφάλου οι επίμυες αρχικά τοποθετήθηκαν σε ένα 

γυάλινο δοχείο στο οποίο υπήρχε ένα βαμβάκι εμποτισμένο με διαίθυλαιθέρα με 

σκοπό να προκληθεί αναισθησία. Αφού επιτεύχθηκε η αναισθησία 

χρησιμοποιήθηκε λαιμητόμος για τον διαχωρισμό του κεφαλιού από το υπόλοιπο 

σώμα και τελικά έγινε διάνοιξη του κρανίου και απομόνωση του εγκεφάλου με 

χειρισμό παρόμοιο με αυτόν που έγινε για την απομόνωση του εγκεφάλου στην 

διαδικασία της ενδοκαρδιακής μονιμοποίησης. Ο εγκέφαλος τοποθετήθηκε σε πάγο 

και από αυτόν λήφθηκαν οι περιοχές προς μελέτη οι οποίες τοποθετήθηκαν σε 

Eppendorf και στη συνέχεια αποθηκεύτηκαν στους -80οC μέχρι την περεταίρω 

επεξεργασία τους. 

 

Προετοιμασία δειγμάτων 

Για την ομογενοποίηση αρχικά προστέθηκε στα eppendorfs που περιείχαν τις 

περιοχές του εγκεφάλου προς μελέτη διάλυμα lysis buffer με σύσταση 20mM Tris-Cl 

pH=8, 150mM NaCl, 1% Triton X-100, 100mg/mL PMSF, 1mM DTT, 1mM Na3VO4, 

10mM β-glycerolphosphate και έπειτα ομογενοποιήθηκαν με τη βοήθεια του 

ομογενοποιητή Heidolph SilentCrusher S. Ακολούθησε φυγοκέντριση για 5 λεπτά 

στις 10.000 στροφές και σε θερμοκρασία 4οC σε φυγόκετρο Biofuge fresco Heraeus 

και τέλος συλλέχθηκε το υπερκείμενο μία μικρή ποσότητα (5μL) του οποίου 

χρησιμοποιήθηκε για την ποσοτικοποίηση των πρωτεϊνών με τη μέθοδο Bradford 

ενώ μεγαλύτερη ποσότητα (150μL) χρησιμοποιήθηκε στη μέθοδο της 

ανοσοαποτύπωσης κηλίδας (Dot blot). 

 

Ποσοτικοποίηση των πρωτεϊνών με τη μέθοδο Bradford 

Με τη μέθοδο Bradford μετρήθηκε η ποσότητα της πρωτεΐνης στα δείγματα. Η 

μέθοδος αυτή βασίζεται στην απορρόφηση της χρωστικής Coomassie brilliant blue 

G-250 η οποία μπορεί και προσδένεται στους πεπτιδικούς δεσμούς μίας πρωτεΐνης. 
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Κατά τη διαδικασία, στο Eppendorf που περιείχε τα 5 μL δείγματος προστέθηκε 

νερό και διάλυμα Coomassie brilliant blue G-250 σε φωσφορικό οξύ και μεθανόλη 

της εταιρίας Biorad. Από το Eppendorf λήφθηκε μία ποσότητα και προστέθηκε σε 

πλάκα ELISA η οποία όταν συμπληρώθηκε με τα επιθυμητά δείγματα 

φωτομετρήθηκε στα 630nm σε φωτόμετρο Bio-Tek ELx800. Οι τιμές απορρόφησης 

που έδειξε το φωτόμετρο μετατράπηκαν σε τιμές συγκέντρωσης πρωτεΐνης με τη 

χρήση καμπύλης αναφοράς που φτιάχτηκε με την μέτρηση της απορρόφησης 

γνωστών συγκεντρώσεων της πρωτεΐνης αλβουμίνης βόειου ορού (Bovine serum 

albumin, BSA). 

 

 

Πρωτόκολλο ανοσοαποτύπωσης κηλίδας  

Η διαδικασία της ανοσοαποτύπωσης κηλίδας (Dot blot), όπως και της 

ανοσοϊστοχημείας παραπάνω, πραγματοποιείται σε 2 μέρες. 

Στην αρχή της 1ης μέρας είναι απαραίτητη η τοποθέτηση της συσκευής σε λεκάνη με 

νερό. Στο μεταξύ, μεμβράνη νιτροκυτταρίνης κόβεται σε διαστάσεις που ταιριάζουν 

με τη συσκευή (11,5x8) και τοποθετείται σε διάλυμα 0,1Μ TBS pH=7,4 για 20-30 

λεπτά. Έπειτα, συναρμολογείται η συσκευή όπως φαίνεται στην Εικόνα 23 μέχρι την 

τοποθέτηση του ελαστικού τμήματός της πάνω στο οποίο τελικά θα τοποθετηθεί η 

μεμβράνη νιτροκυτταρίνης. 
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Εικόνα 23: Σχηματική απεικόνιση των βημάτων για τη σωστή συναρμολόγηση της συσκευής για τη 
μέθοδο Dot blot. 

 

Αφού βεβαιωθεί ότι δεν υπάρχουν φυσαλίδες ανάμεσα στη μεμβράνη και στο 

ελαστικό τμήμα της συσκευής, ακολουθεί το βίδωμα της συσκευής με τρόπο ώστε 

να εξασφαλίζεται η ομοιόμορφη πίεση στη μεμβράνη σε όλη τη διαδικασία του 

βιδώματος. Στη συνέχεια, η συσκευή συνδέεται με πηγή κενού μέσω ειδικού 

πλαστικού σωλήνα και ανοίγει η βαλβίδα για το κενό ώστε να εφαρμόσει καλύτερα 

η μεμβράνη στο λάστιχο και να στεγνώσει περισσότερο. Το επόμενο βήμα είναι η 

επανενυδάτωση της μεμβράνης με προσθήκη TBS σε κάθε πηγαδάκι με multi-

πιπέτα αφού πρώτα γυρίσει η βαλβίδα στον αέρα. Μετά από μικρό χρονικό 

διάστημα απομακρύνεται το TBS που παραμένει με τη βοήθεια του κενού. Μόλις 

απομακρυνθεί πλήρως το TBS γίνεται η προσθήκη δείγματος σε κάθε πηγαδάκι με 

τη βαλβίδα στον αέρα και η συσκευή αφήνεται έτσι μέχρι να προσροφηθούν οι 

πρωτεΐνες στην μεμβράνη, κάτι που διευκολύνεται με την αφαίρεση του υγρού που 

συσσωρεύεται στον πλαστικό σωλήνα με ένα πουάρ. Αφού η προσρόφηση 

ολοκληρωθεί προστίθεται TBS σε κάθε πηγαδάκι το οποίο μετά από λίγο 

απομακρύνεται με τη βοήθεια κενού για τον σκοπό των πλύσεων της μεμβράνης. 
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Ακολουθεί η τοποθέτηση της μεμβράνης σε διάλυμα με την χρωστική Ponseau που 

είναι μία χρωστική που βάφει πρωτεΐνες για 5 λεπτά ώστε να γίνει έλεγχος 

προσρόφησης των πρωτεϊνών στη μεμβράνη. Για να απομακρυνθεί η χρωστική από 

τη μεμβράνη έγιναν πλύσεις αυτής με διάλυμα TBS υπό ανάδευση. Το επόμενο 

βήμα είναι η κατασκευή διαλυμάτων 5% BSA σε TBS-Tween 20 και 5% σκόνης 

γάλακτος Regilait σε TBS-Tween 20 και η επώαση της μεμβράνης για 30 λεπτά σε 

καθένα από αυτά για την κατάληψη των μη ειδικών θέσεων πρόσδεσης του 

αντισώματος που θα προστεθεί στη συνέχεια από την πρωτεΐνη BSA και τις 

πρωτεΐνες του γάλακτος (blocking). Στη συνέχεια γίνονται δύο πλύσεις 10 λεπτών η 

καθεμία με διάλυμα TBS-Tween 20 υπό ανάδευση. Μετά τις πλύσεις οι μεμβράνες 

είναι έτοιμες να δεχτούν το διάλυμα του 1ου αντισώματος το οποίο προήλθε από 

κουνέλι και στόχευε τον παράγοντα NeuN (Sigma MABN140) και ήταν σε 

συγκέντρωση 1/1000. Το διάλυμα του 1ου αντισώματος ήταν το Ab-1 το οποίο 

περιείχε 0,1% BSA σε TBS-Tween 20. Η επώαση της μεμβράνης με το διάλυμα αυτό 

διήρκησε 16-18 ώρες σε ψυχρό θάλαμο 4οC υπό ανάδευση. 

Η 2η μέρα ξεκινά με 3 πλύσεις των 5 λεπτών η καθεμία με διάλυμα 0,1 Μ TBS-

Tween 20 υπό ανάδευση. Έπειτα, η μεμβράνη επωάζεται για 1 ώρα με το 2o 

αντίσωμα το οποίο στοχεύει το 1ο και είναι το anti-rabbit IgG, HRP-linked 7074 cell 

signalling σε συγκέντρωση 1/2000. Το 2ο αντίσωμα ήταν διαλυμένο σε 0,1Μ TBS-

Tween 20. Μετά την επώαση γίνονται 3 πλύσεις οι οποίες είναι 15 λεπτά με 0,1 TBS-

Tween 20, 5 λεπτά με 0,1 TBS-Tween 20 και 5 λεπτά με TBS. Ακολούθως η μεμβράνη 

εκτίθεται σε διάλυμα λουμινόλης, που η σύστασή του είναι 10mL λουμινόλη, 100mL 

κουμαρικού οξέος και 50mL Η2Ο2, για 2-5 λεπτά υπό συνθήκες σκότους. Τέλος, 

γίνεται η ανίχνευση της ακτινοβολίας που παράγεται από την αντίδραση της 

υπεροξειδάσης της HRP με τη λουμινόλη με τη βοήθεια του μηχανήματος Uvitec 

Cambridge.  

Για την εξαγωγή έγκυρων αποτελεσμάτων είναι απαραίτητη η κανονικοποίηση των 

αποτελεσμάτων του σήματος του παράγοντα NeuN που λαμβάνεται με το σήμα 

μίας πρωτεΐνης-μάρτυρα που είναι γνωστό ότι η έκφραση της είναι σταθερή και δεν 

αλλάζει από τις παραμέτρους του πειράματος. Η πρωτεΐνη που ανιχνεύτηκε για τον 

σκοπό αυτό ήταν η β-ακτίνη. Για να συμβεί αυτό θα πρέπει αρχικά η μεμβράνη να 
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επιστρέψει στην κατάσταση που ήταν πριν χρησιμοποιηθεί το 1ο αντίσωμα για τον 

παράγοντα NeuN, δηλαδή να απομακρυνθούν τα αντισώματα από τη μεμβράνη. Η 

διαδικασία με την οποία γίνεται αυτό ονομάζεται stripping και ξεκινά με την έκθεση 

της μεμβράνης σε διάλυμα που αποτελείται από 0,750gr γλυκίνη, 500μl Tween 20 

και 5ml SDS (Sodium dodecyl sulfate) διαλυμένα σε dH2O δύο φορές για 10 λεπτά η 

κάθε φορά ενώ ακολουθούν 4 πλύσεις με 0,1Μ TBS-Tween 20 οι πρώτες δύο για 10 

λεπτά και οι υπόλοιπες δύο για 5 λεπτά. Στη συνέχεια, ακολουθεί επώαση με 

διαλύματα BSA και γάλακτος για 1 ώρα συνολικά όπως ακριβώς αναφέρθηκε και 

παραπάνω με σκοπό το blocking και ακολουθείται η ίδια ακριβώς διαδικασία με 

παραπάνω με την προσθήκη αντισωμάτων αυτή τη φορά για την ανίχνευση της 

ακτίνης. Το 1ο και το 2ο αντίσωμα για την β-ακτίνη που χρησιμοποιήθηκαν ήταν 

διαλυμένα στα ίδια διαλύματα κατά αντιστοιχία με τα διαλύματα του 1ου και 2ου 

αντισώματος για την ανίχνευση NeuN. Συγκεκριμένα το 1ο αντίσωμα για την β-

ακτίνη ήταν το anti-β-actin Sigma A5316 προερχόμενο από ποντίκι και σε 

συγκέντρωση 1/1000 ενώ το 2ο ήταν το anti-mouse IgG, HRP-linked, Cell Signaling 

7076 και σε συγκέντρωση 1/2000. 

 

 

Ανάλυση εικόνας 

Για την ανάλυση των φωτογραφιών χρησιμοποιήθηκε το πρόγραμμα ImageJ. Αρχικά 

με το Εργαλείο Ορθογώνιας Επιλογής (Rectanglular Selection) επιλέχθηκε η 

αριστερή μπάντα της φωτογραφίας και πληκτρολογήθηκε η συντόμευση Ctrl+1. 

Έπειτα, η ορθογώνια επιλογή μεταφέρθηκε προς τα δεξιά στην επόμενη μπάντα και 

πληκτρολογήθηκε η συντόμευση Ctrl+2, κάτι που συνεχίστηκε μέχρι την τελευταία 

μπάντα στην οποία πληκτρολογήθηκε Ctrl+3. Έτσι, δημιουργούνται οι γραφικές 

παραστάσεις των προφίλ κάθε μπάντας οι οποίες αν είναι ανάποδα μπορούν να 

αναστραφούν με την επιλογή Analyze>Gels>Gel Analyzer Options και αποεπιλογή 

του Invert peaks. Με το Εργαλείο Επιλογής Ευθείας Γραμμής (Straight) σχεδιάζονται 

οι βάσεις κάθε κορυφής έτσι ώστε να δημιουργηθούν κλειστές περιοχές. Τέλος, 

μετράται το μέγεθος κάθε κλειστής περιοχής κάνοντας click μέσα σε αυτή με το 
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ποντίκι έχοντας επιλεγμένο το Εργαλείο Ραβδιού (Wand Tool). Τα αποτελέσματα 

των μετρήσεων μεταφέρθηκαν στο πρόγραμμα Excel για περεταίρω επεξεργασία. 

 

 

Στατιστική ανάλυση αποτελεσμάτων 

Για τη στατιστική ανάλυση των αποτελεσμάτων όλων των πειραμάτων 

χρησιμοποιήθηκε το λογισμικό πρόγραμμα GraphPad Prism. Έγινε στατιστική 

ανάλυση με τη χρήση unpaired t-test και σύγκριση των ζώων που είχαν εκτεθεί 

προγεννητικά στην αλκοόλη με τα ζώα ελέγχου. Τιμές p < 0,05 θεωρήθηκαν 

στατιστικά σημαντικές. 
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Αποτελέσματα 

 

Επίδραση της ηλικίας 

Η μάζα του εγκεφάλου ενός επίμυ μπορεί να αυξηθεί περισσότερο από 6 φορές 

από την στιγμή της γέννησης μέχρι την ενηλικίωση, κάτι που μπορεί να επιφέρει 

δραματικές αλλαγές στην κυτταρική σύνθεση του εγκεφάλου με προσθήκες και 

αφαιρέσεις κυττάρων αλλά και αλλαγές στο μέγεθος των κυττάρων κυρίως τους 

πρώτους μήνες μετά τη γέννηση [33]. Για τον λόγο αυτό αρχικά εξετάστηκε η 

επίδραση της ηλικίας στην έκφραση των σωματιδίων Nissl στις διάφορες περιοχές 

που μελετήθηκαν. 

 

Επίδραση της ηλικίας στην πυκνότητα των σωματιδίων Nissl  

Έσω προμετωπιαίος φλοιός (Προμεταιχμιακός φλοιός) 

Η ένταση σήματος των σωματιδίων Nissl μετά από τη χρώση τους με Cresyl violet 

στην περιοχή του προμεταιχμιακού φλοιού (Prl) ήταν κατά μέσο όρο 10,30 ± 1,45 

στα ζώα ελέγχου 2 μηνών και 10,57 ± 0,80 στα ζώα ελέγχου 3,5 μηνών σύμφωνα με 

την κλίμακα έντασης σήματος 256 σημείων. Με στατιστική επεξεργασία των 

αποτελεσμάτων έντασης σήματος με t-test στο πρόγραμμα prism δεν φάνηκε να 

υπάρχει κάποια στατιστικώς σημαντική διαφορά στην ένταση σήματος ανάμεσα 

στα ζώα ελέγχου 2 μηνών και 3,5 μηνών (pvalue > 0,05, Εικόνα 24). Στην εικόνα 25 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του έσω 

προμετωπιαίου φλοιού (προμεταιχμιακός φλοιός) σε ζώα ελέγχου 2 και 3,5 μηνών. 
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Εικόνα 24:  Σύγκριση της έντασης σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου 2 και 3,5 
μηνών στον προμεταιχμιακός φλοιός, (n=4). 

 

 

Εικόνα 25: Χρώση σωματιδίων Nissl στην περιοχή του έσω προμετωπιαίου φλοιού Α. Ζώα ελέγχου 
ηλικίας 2 μηνών, Β. Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Ραχιαίο ραβδωτό σώμα (κερκοφόρος & κελύφος) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του ραχιαίου ραβδωτού σώματος (Κερκοφόρος & Κελύφος) ήταν κατά μέσο 

όρο 20,73 ± 4,22 στα ζώα ελέγχου 2 μηνών και 20,91 ± 1,95 στα ζώα ελέγχου 3,5 

μηνών σύμφωνα με την κλίμακα έντασης σήματος 256 σημείων. Με στατιστική 

ανάλυση των αποτελεσμάτων έντασης σήματος με t-test στο πρόγραμμα prism δεν 

φάνηκε κάποια στατιστικώς σημαντική διαφορά στην ένταση σήματος ανάμεσα στα 

ζώα ελέγχου 2 μηνών και 3,5 μηνών (pvalue > 0,05, Εικόνα 26). Στην εικόνα 27 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του ραβδωτού 

σώματος (Κερκοφόρος & Κέλυφος) σε ζώα ελέγχου 2 και 3,5 μηνών. 

Prelimbic Cortex (PrL)
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Εικόνα 26:  Σύγκριση της έντασης σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου 2 και 3,5 
μηνών στο ραχιαίο ραβδωτό σώμα (Κερκοφόρος & Κέλυφος, n=4). 

 

 

Εικόνα 27: Χρώση σωματιδίων Nissl στην περιοχή του ραχιαίου ραβδωτού σώματος. Α. Ζώα ελέγχου 
ηλικίας 2 μηνών, Β. Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Κοιλιακό ραβδωτό σώμα (Επικλινής πυρήνας) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κεντρικού τμήματος (πυρήνας) του επικλινούς πυρήνα ήταν κατά μέσο 

όρο 19,23 ± 1,50 στα ζώα ελέγχου 2 μηνών και 9,86 ± 1,63 στα ζώα ελέγχου 3,5 

μηνών σύμφωνα με την κλίμακα έντασης σήματος 256 σημείων. Από τη στατιστική 

ανάλυση των αποτελεσμάτων με τη δοκιμή t-test στο πρόγραμμα prism προέκυψε 

στατιστικώς σημαντική μείωση στην ένταση σήματος των σωματιδίων Nissl στα ζώα 

ελέγχου 3,5 μηνών σε σχέση με τα ζώα ελέγχου 2 μηνών (pvalue < 0,01, εικόνα 28). 

Caudate-Putamen (CPu)
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Εικόνα 28: Σύγκριση της έντασης σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου 2 και 3,5 
μηνών στο κεντρικό τμήματος του επικλινούς πυρήνα (n=4). 

 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κελύφους του επικλινούς πυρήνα ήταν κατά μέσο όρο 22,90 ± 1,52 στα 

ζώα ελέγχου 2 μηνών και 8,93 ± 1,88 στα ζώα ελέγχου 3,5 μηνών σύμφωνα με την 

κλίμακα έντασης σήματος 256 σημείων. Από τη στατιστική ανάλυση των 

αποτελεσμάτων με τη δοκιμή t-test στο πρόγραμμα prism φάνηκε στατιστικώς 

σημαντική μείωση στην ένταση σήματος των σωματιδίων Nissl στα ζώα ελέγχου 3,5 

μηνών σε σχέση με τα ζώα ελέγχου 2 μηνών (pvalue < 0,01, εικόνα 29). 

Στην εικόνα 30 παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του 

κεντρικού τμήματος και του κελύφους του επικλινούς πυρήνα σε ζώα ελέγχου 2 και 

3,5 μηνών. 

 

Εικόνα 29: Σύγκριση της έντασης σήματος των σωματιδίων ανάμεσα στα ζώα ελέγχου 2 και 3,5 
μηνών στο κέλυφος του επικλινούς πυρήνα (n=4). 

 

Nucleus Accumbens Core (AcbC)
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Nucleus Accumbens Shell (AcbSh)
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Εικόνα 30: Χρώση σωματιδίων Nissl στην περιοχή του επικλινούς πυρήνα. Α. Ζώα ελέγχου ηλικίας 2 
μηνών, Β. Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Αμυγδαλή (Κεντρικός πυρήνας) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κεντρικού πυρήνα της αμυγδαλής ήταν κατά μέσο όρο 28,58 ± 3,90 στα 

ζώα ελέγχου ηλικίας 2 μηνών και 12,94 ± 2,71 στα ζώα ελέγχου ηλικίας 3,5 μηνών 

σύμφωνα με την κλίμακα έντασης σήματος 256 σημείων. Η στατιστική ανάλυση των 

αποτελεσμάτων με τη δοκιμή t-test στο πρόγραμμα prism έδειξε στατιστικώς 

σημαντική μείωση στην ένταση σήματος των σωματιδίων Nissl στα ζώα ελέγχου 3,5 

μηνών σε σχέση με τα ζώα ελέγχου 2 μηνών (pvalue < 0,05, Εικόνα 31). Στην εικόνα 32 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του κεντρικού 

πυρήνα της αμυγδαλής σε ζώα ελέγχου 2 και 3,5 μηνών. 

 

Εικόνα 31: Σύγκριση της έντασης σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου 2 και 3,5 
μηνών στον κεντρικό πυρήνα της αμυγδαλής (n=4). 

 

Central Amygdala (CeA)
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Εικόνα 32: Χρώση σωματιδίων Nissl στην περιοχή του κεντρικού πυρήνα της αμυγδαλής. Α. Ζώα 
ελέγχου ηλικίας 2 μηνών, Β. Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Επίδραση της Ηλικίας στον Αριθμό των Κυττάρων του Ραχιαίου Ραβδωτού 

Σώματος 

Συνολικός Αριθμός Κυττάρων 

Αν και η σήμανση των σωματιδίων Nissl αποτελεί δείκτη των επιπέδων 

πρωτεϊνοσύνθεσης των νευρικών (κυρίως) κυττάρων εντούτοις δεν αποτελεί 

ένδειξη του αριθμού των νευρώνων που εκφράζονται σε μια περιοχή. Για το λόγο 

αυτό μελετήθηκαν οι πιθανές αλλαγές στον αριθμό των κυττάρων, εστιάζοντας στο 

ραβδωτό σώμα καθώς ο επικλινής πυρήνας που αποτελεί τμήμα του είναι η 

περιοχή στην οποία φάνηκε η μεγαλύτερη μεταβολή στην ένταση σήματος των 

σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου ηλικίας 2 μηνών και στα ζώα ελέγχου 

ηλικίας 3,5 μηνών. 

Η χρώση των κυττάρων του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) με DAPI 

έδειξε στατιστικώς σημαντική μείωση στον συνολικό αριθμό των κυττάρων στην 

περιοχή αυτή (pvalue < 0,01) στα ζώα ελέγχου ηλικίας 3,5 μηνών σε σχέση με τα ζώα 

ελέγχου ηλικίας 2 μηνών (Εικόνα 33). Η στατιστική ανάλυση έγινε στο πρόγραμμα 

prism με τη δοκιμή t-test. Στην εικόνα 34 παρουσιάζονται ενδεικτικές φωτογραφίες 

από τομές εγκεφαλικού ιστού στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & 

Κελύφος) που έγινε χρώση με DAPI στα ζώα ελέγχου 2 και 3,5 μηνών. 
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Εικόνα 33: Σύγκριση του συνολικού αριθμού κυττάρων ανάμεσα στα ζώα ελέγχου ηλικίας 2 και 3,5 
μηνών στο ραχιαίο ραβδωτό σώμα,( n=4). 

 

  

Εικόνα 34:  Χρώση πυρήνων με DAPI ραχιαίο ραβδωτό σώμα. Α. Ζώα ελέγχου ηλικίας 2 μηνών, Β. 
Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Αριθμός Νευρώνων 

Με ανοσοαποτύπωση του παράγοντα NeuN δόθηκε η δυνατότητα εντοπισμού και 

μέτρησης του αριθμού μόνο των νευρικών κυττάρων στην περιοχή του ραβδωτού 

σώματος (Κερκοφόρος & Κελύφος). Τα αποτελέσματα της στατιστικής ανάλυσης με 

τη δοκιμή t-test στο πρόγραμμα prism έδειξαν στατιστικώς σημαντική μείωση στον 

αριθμό των νευρικών κυττάρων στα ζώα ελέγχου 3,5 μηνών σε σχέση με τα ζώα 

ελέγχου 2 μηνών (pvalue < 0,05, Εικόνα 35). Στην εικόνα 36 παρουσιάζονται 

ενδεικτικές φωτογραφίες από τομές εγκεφαλικού ιστού στην περιοχή του 

ραβδωτού σώματος (Κερκοφόρος & Κελύφος) μετά από ανοσοαποτύπωση του 

παράγοντα NeuN στα ζώα ελέγχου 2 και 3,5 μηνών. 
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Εικόνα 35: Σύγκριση του αριθμού των νευρικών ανάμεσα στα ζώα ελέγχου ηλικίας 2 και 3,5 μηνών 
στο ραχιαίο ραβδωτό σώμα,( n=4). 

 

Εικόνα 36: Ανοσοϊστοχημικός εντοπισμός του NeuN στο ραχιαίο ραβδωτό σώμα. Α. Ζώα ελέγχου 
ηλικίας 2 μηνών, Β. Ζώα ελέγχου ηλικίας 3,5 μηνών. 

 

Αριθμός Μη Νευρικών Κυττάρων 

Με αφαίρεση του αριθμού των νευρικών κυττάρων από τον συνολικό αριθμό των 

κυττάρων δόθηκε η δυνατότητα μέτρησης του αριθμού των μη νευρικών κυττάρων 

στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) στα ζώα ελέγχου 2 

μηνών σε σχέση με τα ζώα ελέγχου 3,5 μηνών. Με στατιστική ανάλυση των 

αποτελεσμάτων στο πρόγραμμα prism με τη δοκιμή t-test δεν βρέθηκε κάποια 

στατιστικώς σημαντική διαφορά ανάμεσα στον αριθμό των μη νευρικών κυττάρων 

στην περιοχή αυτή (pvalue > 0,05, Εικόνα 37). 
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Εικόνα 37: Σύγκριση του αριθμού των μη νευρικών ανάμεσα στα ζώα ελέγχου ηλικίας 2 και 3,5 
μηνών στο ραχιαίο ραβδωτό σώμα (n=4). 

 

Επίδραση της προγεννητικής έκθεσης στην αλκοόλη 

Επίδραση της Προγεννητικής Έκθεσης στην Αλκοόλη στην Πυκνότητα των 

Σωματιδίων Nissl 

Έσω προμετωπιαίος φλοιός (Προμεταιχμιακός φλοιός) 

Η ένταση σήματος των σωματιδίων Nissl μετά από τη χρώση τους με Cresyl violet 

στην περιοχή του προμεταιχμιακού φλοιού (Prl) ήταν κατά μέσο όρο 10,75 ± 1,88 

στα ζώα ηλικίας 2 μηνών που εκτέθηκαν προγεννητικά στην αιθανόλη (prenatal 

alcohol exposure, PAE) και 11,89 ± 3,56 στα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν 

προγεννητικά στην αιθανόλη σύμφωνα με την κλίμακα έντασης σήματος 256 

σημείων. Με στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα prism με τη 

δοκιμή t-test δεν φάνηκε κάποια σημαντική διαφορά ανάμεσα στα ζώα ελέγχου 2 

μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας (pvalue > 0,05, Εικόνα 

38) ούτε ανάμεσα στα ζώα ελέγχου 3,5 μηνών και σε αυτά που εκτέθηκαν στην 

αιθανόλη ίδιας ηλικίας (pvalue > 0,05, Εικόνα 39). Στην εικόνα 40 παρουσιάζονται 

ενδεικτικές φωτογραφίες τομών στην περιοχή του προμεταιχμιακού φλοιού σε ζώα 

ελέγχου 2 μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας ενώ στην 

εικόνα 41 παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του 

προμεταιχμιακού φλοιού σε ζώα ελέγχου 3,5 μηνών και σε αυτά που εκτέθηκαν 

στην αιθανόλη ίδιας ηλικίας. 
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Εικόνα 38: Έντασης σήματος των σωματιδίων Nissl στον προμεταιχμιακό φλοιό ζώων ηλικίας 2 
μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4). 

 

 

Εικόνα 39: Έντασης σήματος των σωματιδίων Nissl στον προμεταιχμιακό φλοιό ζώων ηλικίας 3.5 
μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4). 

 

Εικόνα 40: Χρώση σωματιδίων Nissl στην περιοχή του προμεταιχμιακού φλοιού ζώων 2 μηνών. Α. 
Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη . 
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Εικόνα 41: Χρώση σωματιδίων Nissl στην περιοχή του προμεταιχμιακού φλοιού ζώων 3.5 μηνών. Α. 
Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 

 

Ραχιαίο ραβδωτό σώμα (κερκοφόρος & κελύφος) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) ήταν κατά μέσο όρο 

11,25 ± 3,65 στα ζώα ηλικίας 2 μηνών που εκτέθηκαν στην αιθανόλη και 13,15 ± 

0,41 στα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν στην αιθανόλη σύμφωνα με την 

κλίμακα έντασης σήματος 256 σημείων. Η στατιστική ανάλυση των αποτελεσμάτων 

στο πρόγραμμα prism με τη δοκιμή t-test δεν έδειξε στατιστικώς σημαντική 

διαφορά ανάμεσα στα ζώα ελέγχου 2 μηνών και στα ζώα που εκτέθηκαν στην 

αιθανόλη ηλικίας 2 μηνών (pvalue > 0,05, Εικόνα 42) ενώ στα ζώα ηλικίας 3,5 μηνών 

που εκτέθηκαν στην αιθανόλη η ένταση σήματος των σωματιδίων Nissl φάνηκε 

μειωμένη σε σχέση με την ένταση σήματος στα ζώα ελέγχου ίδιας ηλικίας (pvalue < 

0,05, Εικόνα 43). Στην εικόνα 44 παρουσιάζονται ενδεικτικές φωτογραφίες τομών 

στην περιοχή του ραβδωτού σώματος (κερκοφόρος & κελύφος) στα ζώα ελέγχου 2 

μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας ενώ στην εικόνα 45 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του ραβδωτού 

σώματος (κερκοφόρος & κελύφος) στα ζώα ελέγχου 3,5 μηνών και σε αυτά που 

εκτέθηκαν στην αιθανόλη ίδιας ηλικίας. 
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Εικόνα 42: Έντασης σήματος των σωματιδίων Nissl στο ραχιαίο ραβδωτό σώμα ζώων ηλικίας 2 
μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4). 

 

Εικόνα 43: Έντασης σήματος των σωματιδίων Nissl στο ραχιαίο ραβδωτό σώμα ζώων ηλικίας 3.5 
μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη  (Control: 
n=4, PAE: n=3). 

 

 

Εικόνα 44: Χρώση σωματιδίων Nissl στην περιοχή του ραχιαίου ραβδωτού σώματος ζώων 2 μηνών. 
Α. Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 
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Εικόνα 45: Χρώση σωματιδίων Nissl στην περιοχή του ραχιαίου ραβδωτού σώματος ζώων 3.5 μηνών. 
Α. Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 

 

Κοιλιακό ραβδωτό σώμα (Επικλινής πυρήνας) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κεντρικού τμήματος (πυρήνας) του επικλινούς πυρήνα ήταν κατά μέσο 

όρο 12,96 ± 5 στα ζώα 2 μηνών που εκτέθηκαν στην αιθανόλη και 21,03 ± 7,63 στα 

ζώα 3,5 μηνών που εκτέθηκαν στην αιθανόλη σύμφωνα με την κλίμακα έντασης 

σήματος 256 σημείων. Η στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test δεν έδειξε στατιστικώς σημαντική διαφορά στην ένταση 

σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου και σε αυτά που 

εκτέθηκαν στην αιθανόλη ηλικίας 2 μηνών (pvalue > 0,05, Εικόνα 46) ούτε ανάμεσα 

στα ζώα ελέγχου και σε αυτά που εκτέθηκαν στην αιθανόλη ηλικίας 3,5 μηνών 

(pvalue > 0,05, Εικόνα 47). 

 

Εικόνα 46:  Έντασης σήματος των σωματιδίων Nissl στο κεντρικό τμήμα του επικλινούς πυρήνα ζώων 
ηλικίας 2 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη 
(n=4). 
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Εικόνα 47: Έντασης σήματος των σωματιδίων Nissl στο κεντρικό τμήμα του επικλινούς πυρήνα ζώων 
ηλικίας 3.5 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε 
αιθανόλη (Control: n=4, PAE: n=3) 

 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κελύφους του επικλινούς πυρήνα ήταν κατά μέσο όρο 16,41 ± 5,53 στα 

ζώα ηλικίας 2 μηνών που εκτέθηκαν στην αιθανόλη και 26,8 ± 4,44 στα ζώα ηλικίας 

3,5 μηνών που εκτέθηκαν στην αιθανόλη σύμφωνα με την κλίμακα έντασης 

σήματος 256 σημείων. Με στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test δεν προέκυψε στατιστικώς σημαντική διαφορά στην 

ένταση σήματος των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου ηλικίας 2 μηνών 

και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας (pvalue > 0,05, Εικόνα 48) 

όμως παρατηρήθηκε στατιστικώς σημαντικά μειωμένη ένταση σήματος στα ζώα 

ελέγχου ηλικίας 3,5 μηνών σε σχέση με τα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν 

στην αιθανόλη (pvalue < 0,01, Εικόνα 49). 
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Εικόνα 48: Έντασης σήματος των σωματιδίων Nissl στο κέλυφος του επικλινούς πυρήνα ζώων ηλικίας 
2 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4).  

 

Εικόνα 49: Έντασης σήματος των σωματιδίων Nissl στο κέλυφος του επικλινούς πυρήνα ζώων ηλικίας 
3.5 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη 
(Control: n=4, PAE: n=3) 

 

Στην εικόνα 50 παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του 

κεντρικού τμήματος και του κελύφους του επικλινούς πυρήνα σε ζώα ελέγχου 2 

μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας και στην εικόνα 51 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του κεντρικού 

τμήματος και του κελύφους του επικλινούς πυρήνα σε ζώα ελέγχου 3,5 μηνών και 

σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας. 

 

Εικόνα 50: Χρώση σωματιδίων Nissl στην περιοχή του κοιλιακού ραβδωτού σώματος ζώων 2 μηνών. 
Α. Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 
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Εικόνα 51: Χρώση σωματιδίων Nissl στην περιοχή του κοιλιακού ραβδωτού σώματος ζώων 3.5 
μηνών. Α. Ζώο ελέγχου, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 

 

Αμυγδαλή (Κεντρικός πυρήνας) 

Η ένταση σήματος των σωματιδίων Nissl μετά από χρώση τους με Cresyl violet στην 

περιοχή του κεντρικού πυρήνα της αμυγδαλής ήταν κατά μέσο όρο 12,66 ± 2,58 στα 

ζώα που εκτέθηκαν στην αιθανόλη ηλικίας 2 μηνών και 13,77 ± 1,71 στα ζώα που 

εκτέθηκαν στην αιθανόλη ηλικίας 3,5 μηνών σύμφωνα με την κλίμακα έντασης 

σήματος 256 σημείων. Η στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test έδειξε στατιστικώς σημαντικά μειωμένη την ένταση 

σήματος των σωματιδίων Nissl στα ζώα ηλικίας 2 μηνών που εκτέθηκαν στην 

αιθανόλη σε σχέση με τα ζώα ελέγχου ίδιας ηλικίας (pvalue < 0,05, Εικόνα 52) ενώ 

σημαντική διαφορά στην ένταση ανάμεσα στα ζώα που εκτέθηκαν στην αιθανόλη 

3,5 μηνών σε σχέση με τα ζώα ελέγχου ίδιας ηλικίας δεν φάνηκε (pvalue > 0,05, 

Εικόνα 53). Στην εικόνα 54 παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην 

περιοχή της αμυγδαλής στα ζώα ελέγχου 2 μηνών και σε αυτά που εκτέθηκαν στην 

αιθανόλη ίδιας ηλικίας ενώ στην εικόνα 55 παρουσιάζονται ενδεικτικές 

φωτογραφίες τομών στην περιοχή της αμυγδαλής στα ζώα ελέγχου 3,5 μηνών και 

σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας. 
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Εικόνα 52: Έντασης σήματος των σωματιδίων Nissl στον κεντρικό πυρήνα της αμυγδαλής ζώων 
ηλικίας 2 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη 
(n=4) 

 

Εικόνα 53: Έντασης σήματος των σωματιδίων Nissl στον κεντρικό πυρήνα της αμυγδαλής ζώων 
ηλικίας 3.5 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε 
αιθανόλη (Control: n=4, PAE: n=3) 

 

Εικόνα 54: Χρώση σωματιδίων Nissl στην περιοχή της αμυγδαλής σε ζώα 2 μηνών. Α. Ζώα ελέγχου, Β. 
Ζώα που εκτέθηκαν στην αιθανόλη.. 
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Εικόνα 55: Χρώση σωματιδίων Nissl στην περιοχή της αμυγδαλής σε ζώα 3.5 μηνών. Α. Ζώα ελέγχου, 
Β. Ζώα που εκτέθηκαν στην αιθανόλη. 

 

Επίδραση της Προγεννητικής Έκθεσης στην Αλκοόλη στην Έκφραση του Δείκτη 

των Νευρικών - Ζώα 2 Μηνών 

Ραχιαίο ραβδωτό σώμα (κερκοφόρος & κελύφος) 

Δεδομένης της μείωσης στα επίπεδα των σωματιδίων Nissl στο ραβδωτό σώμα 

(Κερκοφόρος & Κέλυφος) ανάμεσα στα ζώα ελέγχου και σε αυτά που εκτέθηκαν 

στην αιθανόλη, εξετάστηκε αν η αλλαγή αυτή συνάδει με αντίστοιχη μείωση της 

έκφρασης του δείκτη των νευρικών κυττάρων NeuN σε αυτή την περιοχή. Επίσης, 

εξετάστηκε η έκφραση του δείκτη αυτού στον μετωπιαίο φλοιό, τμήμα του οποίου 

είναι ο προμεταιχμιακός φλοιός. Τα πειράματα αυτά περιορίστηκαν στην μελέτη 

των ζώων μικρής ηλικίας.  

Η ένταση σήματος του παράγοντα NeuN από την περιοχή του ραβδωτού σώματος 

πάνω στη μεμβράνη νιτροκυτταρίνης (Εικόνα 56) ήταν κατά μέσο όρο 2,95 ± 0,20 

στα ζώα ελέγχου 2 μηνών και 0,35 ± 0,06 στα ζώα ηλικίας 2 μηνών που εκτέθηκαν 

στην αιθανόλη. Από τη στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test φάνηκε στατιστικώς σημαντική μείωση στην ένταση 

σήματος του παράγοντα NeuN στα ζώα που εκτέθηκαν στην αιθανόλη ηλικίας 2 

μηνών σε σχέση με τα ζώα ελέγχου ίδιας ηλικίας με τιμή pvalue < 0,001 (Εικόνα 57). 
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Εικόνα 56: Ανοσοαποτύπωση κυλίδας της πρωτεΐνης NeuN και της β-ακτίνης στο ραβδωτό σώμα 
ζώων 2 μηνών. Σύγκριση ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά στην αιθανόλη. 

 

Εικόνα 57: Ανάλυση των αποτελεσμάτων ανοσοαποτύπωσης της πρωτεΐνης NeuN σε σχέση με τη β-
ακτίνη στο ραβδωτό σώμα ζώων 2 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν 
προγεννητικά σε αιθανόλη. 

 

Προμετωπιαίος φλοιός 

Η ένταση σήματος του παράγοντα NeuN από την περιοχή του μετωπιαίου φλοιού 

πάνω στη μεμβράνη νιτροκυτταρίνης (Εικόνα 58) ήταν κατά μέσο όρο 1,02 ± 0,10 

στα ζώα ελέγχου ηλικίας 2 μηνών και 1,02 ± 0,19 στα ζώα που εκτέθηκαν στην 

αιθανόλη ηλικίας 2 μηνών. Από τη στατιστική ανάλυση των αποτελεσμάτων στο 

πρόγραμμα prism με τη δοκιμή t-test δεν φάνηκε κάποια στατιστικώς σημαντική 

διαφορά στην ένταση σήματος του παράγοντα NeuN στα ζώα που εκτέθηκαν στην 

αιθανόλη ηλικίας 2 μηνών σε σχέση με τα ζώα ελέγχου ίδιας ηλικίας με τιμή pvalue > 

0,05 (Εικόνα 59).  
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Εικόνα 58: Ανοσοαποτύπωση κυλίδας της πρωτεΐνης NeuN και της β-ακτίνης στο μετωπιαίο φλοιό 
ζώων 2 μηνών. Σύγκριση ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά στην αιθανόλη. 

 

Εικόνα 59: Ανάλυση των αποτελεσμάτων ανοσοαποτύπωσης της πρωτεΐνης NeuN σε σχέση με τη β-
ακτίνη στο μετωπιαίο φλοιό ζώων 2 μηνών. Σύγκριση μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν 
προγεννητικά σε αιθανόλη (n=3). 

 

Επίδραση της Προγεννητικής Έκθεσης στην Αλκοόλη στον Αριθμό των Κυττάρων 

του Ραχιαίου Ραβδωτού Σώματος (Κερκοφόρος & Κελύφος) 

Συνολικός Αριθμός Κυττάρων 

Δεδομένης της αλλαγής που παρατηρήθηκε στην έκφραση του δείκτη των νευρικών 

κυττάρων NeuN στο ραβδωτό σώμα (Κερκοφόρος & Κέλυφος) εξετάστηκε αν η 

μείωση που παρατηρήθηκε συνάδει με αντίστοιχη μείωση του αριθμό των 

κυττάρων (νευρικών και μη) σε αυτή την περιοχή. 

Η χρώση των κυττάρων του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) με DAPI 

έδειξε στατιστικώς σημαντική μείωση στον συνολικό αριθμό των κυττάρων στην 
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περιοχή αυτή στα ζώα ηλικίας 2 μηνών που εκτέθηκαν στην αιθανόλη σε σχέση με 

τα ζώα ελέγχου 2 μηνών (pvalue < 0,05, Εικόνα 60) ενώ στατιστικώς σημαντική 

διαφορά στον αριθμό των κυττάρων δεν παρατηρήθηκε ανάμεσα στα ζώα ελέγχου 

ηλικίας 3,5 μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας (pvalue > 

0,05, Εικόνα 61). Η ανάλυση έγινε στο πρόγραμμα prism με τη δοκιμή t-test. Στην 

εικόνα 62 παρουσιάζονται ενδεικτικές φωτογραφίες από τομές εγκεφαλικού ιστού 

στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) που έγινε χρώση με 

DAPI στα ζώα ελέγχου 2 μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ηλικίας 2 

μηνών ενώ στην εικόνα 63 παρουσιάζονται ενδεικτικές φωτογραφίες από τομές 

εγκεφαλικού ιστού στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) 

που έγινε χρώση με DAPI στα ζώα ελέγχου 3,5 μηνών και σε αυτά που εκτέθηκαν 

στην αιθανόλη ηλικίας 3,5 μηνών. 

 

Εικόνα 60:  Συνολικός αριθμός κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 2 μηνών. Σύγκριση μεταξύ 
ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4). 

 

Εικόνα 61:  Συνολικός αριθμός κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 3.5 μηνών. Σύγκριση 
μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (Control: n=4, PAE: n=3). 
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Εικόνα 62: Χρώση πυρήνων με DAPI ραχιαίο ραβδωτό σώμα ζώων 2 μηνών. Α. Ζώο ελέγχου ηλικίας, 
Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 

 

Εικόνα 63: Χρώση πυρήνων με DAPI ραχιαίο ραβδωτό σώμα ζώων 3.5 μηνών. Α. Ζώο ελέγχου 
ηλικίας, Β. Ζώο που εκτέθηκε προγεννητικά σε αιθανόλη. 

 

Αριθμός Νευρώνων 

Με ανοσοαποτύπωση του παράγοντα NeuN δόθηκε η δυνατότητα εντοπισμού και 

μέτρησης του αριθμού μόνο των νευρικών κυττάρων στην περιοχή του ραβδωτού 

σώματος (Κερκοφόρος & Κελύφος). Τα αποτελέσματα της στατιστικής ανάλυσης με 

τη δοκιμή t-test στο πρόγραμμα prism έδειξαν στατιστικώς σημαντικά μειωμένο τον 

αριθμό νευρικών κυττάρων στα ζώα ηλικίας 2 μηνών που εκτέθηκαν στην αιθανόλη 

σε σχέση με τα ζώα ελέγχου ίδιας ηλικίας (pvalue < 0,001, Εικόνα 64) ενώ στατιστικώς 

σημαντική διαφορά στον αριθμό των κυττάρων ανάμεσα στα ζώα ελέγχου 3,5 

μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας δεν υπήρχε (pvalue > 

0,05, Εικόνα 65). Στην εικόνα 66 παρουσιάζονται ενδεικτικές φωτογραφίες από 

τομές εγκεφαλικού ιστού στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & 
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Κελύφος) μετά από ανοσοαποτύπωση του παράγοντα NeuN στα ζώα ελέγχου 2 

μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας ενώ στην εικόνα 67 

παρουσιάζονται ενδεικτικές φωτογραφίες από τομές εγκεφαλικού ιστού στην 

περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) μετά από 

ανοσοαποτύπωση του παράγοντα NeuN στα ζώα ελέγχου 3,5 μηνών και σε αυτά 

που εκτέθηκαν σε αιθανόλη ίδιας ηλικίας. 

 

Εικόνα 64:  Αριθμός νευρικών κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 2 μηνών. Σύγκριση μεταξύ 
ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη ( n=4). 

 

 

Εικόνα 65:  Αριθμός νευρικών κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 3.5 μηνών. Σύγκριση 
μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (Control: n=4, PAE: n=3). 
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Εικόνα 66: Ανοσοϊστοχημικός εντοπισμός του δείκτη των νευρικών κυττάρων NeuN στο ραχιαίο 
ραβδωτό σώμα ζώων 2 μηνών. Α. Ζώο ελέγχου ηλικίας, Β. Ζώο που εκτέθηκε προγεννητικά σε 
αιθανόλη. 

 

Εικόνα 67: Ανοσοϊστοχημικός εντοπισμός του δείκτη των νευρικών κυττάρων NeuN στο ραχιαίο 
ραβδωτό σώμα ζώων 3.5 μηνών. Α. Ζώο ελέγχου ηλικίας, Β. Ζώο που εκτέθηκε προγεννητικά σε 
αιθανόλη. 

 

Αριθμός Μη Νευρικών Κυττάρων 

Με αφαίρεση του αριθμού των νευρικών κυττάρων από τον συνολικό αριθμό των 

κυττάρων δόθηκε η δυνατότητα μέτρησης του αριθμού των μη νευρικών κυττάρων 

στην περιοχή του ραβδωτού σώματος (Κερκοφόρος & Κελύφος) στα ζώα ελέγχου 2 

μηνών σε σχέση με τα ζώα που εκτέθηκαν στην αιθανόλη ηλικίας 2 μηνών καθώς 

και ανάμεσα στα ζώα ελέγχου 3,5 μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη 

ηλικίας 3,5 μηνών. Με στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test δεν παρατηρήθηκε στατιστικώς σημαντική διαφορά στον 

αριθμό των μη νευρικών κυττάρων ανάμεσα στα ζώα ελέγχου και σε αυτά που 

εκτέθηκαν στην αιθανόλη ηλικίας 2 μηνών (pvalue > 0,05, Εικόνα 68) ούτε ανάμεσα 
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στα ζώα ελέγχου και σε αυτά που εκτέθηκαν στην αιθανόλη ηλικίας 3,5 μηνών 

(pvalue > 0,05, Εικόνα 69). 

 

Εικόνα 68: Αριθμός μη νευρικών κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 2 μηνών. Σύγκριση 
μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (n=4). 

 

 

Εικόνα 69:  Αριθμός μη νευρικών κυττάρων στο ραβδωτό σώμα ζώων ηλικίας 3.5 μηνών. Σύγκριση 
μεταξύ ζώων ελέγχου και ζώων που εκτέθηκαν προγεννητικά σε αιθανόλη (Control: n=4, PAE: n=3). 

 

Επίδραση της Προγεννητικής Έκθεσης στην Αλκοόλη στο Πάχος Μεσολοβίου στο 

Επίπεδο του Ιπποκάμπου - Ζώα 2 Μηνών 

Σύγκριση του πάχους του μεσολοβίου στο επίπεδο του ιπποκάμπου 

Η στατιστική ανάλυση μέτρησης του πάχους τους μεσολοβίου σε ζώα ελέγχου 

ηλικίας 2 μηνών στο πρόγραμμα prism με τη δοκιμή ANOVA έδειξε στατιστικώς 

σημαντική διαφορά στο πάχος του μεσολοβίου ανάμεσα στην περιοχή από Βρέγμα 
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-2,16 μέχρι -2,92 και στην περιοχή από Βρέγμα -3,00 μέχρι -3,72 (pvalue < 0,05, Εικόνα 

70). 

 

Εικόνα 70: Διαφοροποίηση του πάχους του μεσολοβίου ανάμεσα στις περιοχές από Βρέγμα -1,80 
μέχρι -2,04, -2,16 μέχρι -2,92, -3,00 μέχρι -3,72 και -3,84 μέχρι -4,80 σε ζώα ελέγχου ηλικίας 2 μηνών 
(n=4). 

 

Επίδραση της Προγεννητικής Έκθεσης στην Αλκοόλη στο Πάχος του Μεσολοβίου 

Η μελέτη της επίδρασης της αιθανόλης στο πάχος του μεσολοβίου περιορίστηκε 

στην περιοχή από Βρέγμα -2,16 μέχρι Βρέγμα -2,92 που είναι μία περιοχή στην 

οποία, όπως αναφέρθηκε και παραπάνω, το πάχος του μεσολοβίου φαίνεται να 

είναι σταθερό. 

Το πάχος του μεσολοβίου από Βρέγμα -2,16 μέχρι Βρέγμα -2,92 στα ζώα ελέγχου 

ηλικίας 2 μηνών ήταν κατά μέσο όρο 231,1 ± 16,37, στα ζώα που εκτέθηκαν στην 

αιθανόλη ηλικίας 2 μηνών ήταν 259 ± 17,37, στα ζώα ελέγχου ηλικίας 3,5 μηνών 

ήταν 181,5 ± 47,04 και στα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν στην αιθανόλη 

ήταν 247,6 ± 3,36. Από τη στατιστική ανάλυση των αποτελεσμάτων στο πρόγραμμα 

prism με τη δοκιμή t-test δεν φάνηκε κάποια στατιστικώς σημαντική διαφορά στο 

πάχος του μεσολοβίου ανάμεσα στα ζώα ελέγχου ηλικίας 2 μηνών και σε αυτά που 

εκτέθηκαν στην αιθανόλη ίδιας ηλικίας (pvalue > 0,05, Εικόνα 71), ούτε 

παρατηρήθηκε κάποια σημαντική διαφορά στο πάχος ανάμεσα στα ζώα ελέγχου 

ηλικίας 3,5 μηνών και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας (pvalue > 

0,05, Εικόνα 72). Στην εικόνα 73 παρουσιάζονται ενδεικτικές φωτογραφίες τομών 

στην περιοχή του μεσολοβίου στο επίπεδο ιπποκάμπου στα ζώα ελέγχου 2 μηνών 
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και σε αυτά που εκτέθηκαν στην αιθανόλη ίδιας ηλικίας ενώ στην εικόνα 74 

παρουσιάζονται ενδεικτικές φωτογραφίες τομών στην περιοχή του μεσολοβίου στο 

επίπεδο του ιπποκάμπου στα ζώα ελέγχου 3,5 μηνών και σε αυτά που εκτέθηκαν 

στην αιθανόλη ίδιας ηλικίας. 

 

 

Εικόνα 71: Σύγκριση του πάχους του μεσολοβίου στο επίπεδο ιπποκάμπου μεταξύ ζώων ελέγχου και 
ζώων που εκτέθηκαν προγεννητικά σε αιθανολη στην ηλικία των 2 μηνών (n=4). 

 

Εικόνα 72: Σύγκριση του πάχους του μεσολοβίου στο επίπεδο ιπποκάμπου μεταξύ ζώων ελέγχου και 
ζώων που εκτέθηκαν προγεννητικά σε αιθανολη στην ηλικία των 3.5 μηνών (n=2). 
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Εικόνα 73: Χρώση σωματιδίων Nissl στην περιοχή του μεσολοβίου στο επίπεδο του ιπποκάμπου σε 
ζώα ηλικίας 2 μηνών Α. Ζώα ελέγχου, Β. Ζώα που εκτέθηκαν στην αιθανόλη . 

 

 

Εικόνα 74: Χρώση σωματιδίων Nissl στην περιοχή του μεσολοβίου στο επίπεδο ιπποκάμπου σε ζώα 
ηλικίας 3.5 μηνών Α. Ζώα ελέγχου, Β. Ζώα που εκτέθηκαν στην αιθανόλη. 
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Συζήτηση 

Η κατανάλωση αιθανόλης κατά τη διάρκεια της εγκυμοσύνης είναι γνωστό ότι 

μπορεί να προκαλέσει πολλά προβλήματα στο αναπτυσσόμενο έμβρυο με 

χαρακτηριστικό παράδειγμα τις βλάβες στο κεντρικό νευρικό σύστημα. Στα πλαίσια 

της συγκεκριμένης εργασίας εξετάστηκε η επίδραση της προγεννητικής έκθεσης 

στην αιθανόλη σε εγκεφάλους ενήλικων επίμυων τύπου Sprague-Dawley με 

επίκεντρο τις περιοχές του προμεταιχμιακού φλοιού (τμήμα του έσω 

προμετωπιαίου φλοιού), του ραχιαίου (κερκοφόρος πυρήνας και κέλυφος) και 

κοιλιακού (επικλινής πυρήνας) ραβδωτού σώματος, του κεντρικού πυρήνα της 

αμυγδαλής και του μεσολοβίου. Η επιλογή των εγκεφαλικών αυτών περιοχών έγινε 

με βάση μια σειρά μελετών [7, 28, 8, 9, 12] στις οποίες διαπιστώθηκε ότι η 

προγεννητική έκθεση στην αιθανόλη είχε επίπτωση σε συμπεριφορικά πρότυπα και 

λειτουργίες που ρυθμίζονται από τις περιοχές αυτές. Επίσης, οι περιοχές αυτές 

συνδέονται μεταξύ τους μέσω νευρώνων ανταλλάσσοντας πληροφορίες οπότε είναι 

λογικό η δυσλειτουργία σε μία περιοχή από την έκθεση στην αιθανόλη να 

επηρεάσει τη λειτουργία μίας άλλης περιοχής με την οποία συνδέεται. Ένας από 

τους τρόπους με τους οποίους η αιθανόλη προκαλεί προβλήματα στις περιοχές που 

μελετήθηκαν είναι η μη φυσιολογική πρόκληση κυτταρικού θανάτου που 

συνεπάγεται την μείωση στον αριθμό των νευρώνων.  

Αρχικά, εξετάστηκε η επίδραση της αιθανόλης στην ένταση σήματος των 

σωματιδίων Nissl, η μείωση του οποίου αποτελεί δείκτη καταστροφής νευρικών 

κυττάρων. Βέβαια, ο ρόλος των σωματιδίων Nissl είναι κυρίως η πρωτεϊνοσύνθεση 

οπότε μεταβολές στο σήμα των σωματιδίων δηλώνουν μεταβολές στην 

πρωτεϊνοσύνθεση και δεν αποτελούν απόλυτα αξιόπιστο δείκτη για τον θάνατο 

κυττάρων. Για αυτό τον λόγο έγινε προσπάθεια μέτρησης του κυτταρικού θανάτου 

που προκαλείται από την αιθανόλη με σήμανση όλων των κυττάρων με DAPI αλλά 

και μόνο των νευρικών κυττάρων με NeuN [35] στην περιοχή του ραχιαίου 

ραβδωτού σώματος (Κερκοφόρος & Κέλυφος). Στις περιπτώσεις που παρατηρήθηκε 

μείωση στων αριθμό όλων των κυττάρων (σήμανση με DAPI) εξαιτίας της επίδρασης 

της ηλικίας ή της έκθεσης στην αιθανόλη, παρατηρήθηκε και μείωση στον αριθμό 
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των νευρικών κυττάρων (σήμανση με NeuN) ενώ δεν παρατηρήθηκε μεταβολή στον 

αριθμό των μη νευρικών κυττάρων. Έτσι, μπορεί να βγει το συμπέρασμα ότι η 

ηλικία ή η αιθανόλη όταν προκάλεσε μεταβολή σε αριθμό κυττάρων επηρέασε μόνο 

νευρώνες και όχι άλλους τύπους κυττάρων στην περιοχή του ραχιαίου ραβδωτού 

σώματος (Κερκοφόρος & Κέλυφος). Ακόμα εξετάστηκε η επίδραση της αιθανόλης 

στην έκφραση του παράγοντα NeuN στην περιοχή του έσω προμετωπιαίου φλοιού 

και του ραχιαίου ραβδωτού σώματος (Κερκοφόρος & Κέλυφος) με τη χρήση 

ανοσοαποτύπωση κηλίδας. 

Μέσος προμετωπιαίος φλοιός 

Σε ότι αφορά τον μέσο προμετωπιαίο φλοιό, η περιοχή του προμεταιχμιακού 

φλοιού δεν φάνηκε να επηρεάζεται από την ηλικία των ζώων καθώς δεν 

παρατηρήθηκε διαφορά στην ένταση σήματος των σωματιδίων Nissl στα ζώα 

ελέγχου ηλικίας 2 και 3,5 μηνών. Επίσης, η περιοχή αυτή δεν φάνηκε να 

επηρεάζεται από την προγεννητική έκθεση στην αιθανόλη με βάση το πρωτόκολλο 

έκθεσης που χρησιμοποιήθηκε καθώς δεν φάνηκε διαφορά στην ένταση σήματος 

των σωματιδίων Nissl ανάμεσα στα ζώα ελέγχου και σε αυτά που εκτέθηκαν στην 

αιθανόλη είτε τα ζώα ήταν ηλικίας 2 μηνών είτε 3,5 μηνών. Τέλος, η προγεννητική 

έκθεση στην αιθανόλη δεν επηρέασε την έκφραση του δείκτη νευρικών κυττάρων 

NeuN στην ευρύτερη περιοχή του μετωπιαίου φλοιού στα ζώα ηλικίας 2 μηνών.  

Αυτά τα αποτελέσματα έρχονται σε αντίθεση με βιβλιογραφικά δεδομένα που 

δείχνουν αύξηση της διαδικασίας της νέκρωσης στα νευρικά κύτταρα στην περιοχή 

του προμετωπιαίου φλοιού σε επίμυες [7]. Στην ίδια μελέτη η μορφολογία του 

προμετωπιαίου φλοιού μαρτυρούσε σημάδια καταστροφής του ενδοπλασματικού 

δικτύου, κάτι που επίσης δεν συμβαδίζει με τα αποτελέσματα μας στον 

προμεταιχμιακό φλοιό καθώς η ένταση των σωματιδίων Nissl δεν φάνηκε να 

επηρεάζεται από το πρωτόκολλο έκθεσης στην αιθανόλη που χρησιμοποιήθηκε. 

Βέβαια τα δεδομένα της συγκεκριμένης μελέτης αφορούν την ευρύτερη περιοχή 

του προμετωπιαίου φλοιού και όχι τον προμεταιχμιακό φλοιό που εδώ μελετήθηκε, 

έγινε σε C57BL/6 ποντικούς και όχι σε Sprague Dawley επίμυες και το πρωτόκολλο 

έκθεσης στην αιθανόλη ήταν διαφορετικό.  
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Ραβδωτό σώμα 

Η περιοχή του ραχιαίου ραβδωτού σώματος (κερκοφόρος & κέλυφος) δεν 

επηρεάστηκε από την ηλικία των ζώων αναφορικά με την ένταση στο σήμα των 

σωματιδίων Nissl καθώς δεν υπήρχε σημαντική διαφορά ανάμεσα στα ζώα ελέγχου 

2 και 3,5 μηνών. Όμως η ηλικία του ζώου φάνηκε να επηρεάζει τον συνολικό αριθμό 

κυττάρων στην περιοχή καθώς στα ζώα ελέγχου 3,5 μηνών ο συνολικός αριθμός των 

κυττάρων ήταν στατιστικώς σημαντικά μειωμένος σε σχέση σε τα ζώα ελέγχου 2 

μηνών. Η ηλικία επηρέασε και τον αριθμό των νευρικών κυττάρων στην περιοχή με 

στατιστικώς σημαντική μείωση στα ζώα ελέγχου 3,5 μηνών ενώ στον αριθμό των μη 

νευρικών κυττάρων στην περιοχή η ηλικία δεν είχε σημαντική επίπτωση. Τα 

αποτελέσματα αυτά συνάδουν με μια προηγούμενη μελέτη σύμφωνα με την οποία 

η ωρίμανση του ραχιαίου ραβδωτού σώματος μεταξύ 3ης εβδομάδος και της ηλικίας 

των 3 μηνών στους επίμυες τύπου Wistar χαρακτηρίζεται από μείωση της 

πυκνότητας των κυττάρων, αύξηση της μυελίνωσης  του ιστού και καμία εμφανή 

αλλαγή στην ιστοχημική χρώση των σωματιδίων Nissl [36]. 

Η προγεννητική έκθεση στην αιθανόλη στα ζώα ηλικίας 2 μηνών δεν επηρέασε 

σημαντικά την πυκνότητα των σωματιδίων Nissl της περιοχής όμως μείωσε 

σημαντικά την πυκνότητα των σωματιδίων στα ζώα 3,5 μηνών. Επιπλέον, φάνηκε 

σημαντική μείωση στην έκφραση του δείκτη των νευρικών κυττάρων NeuN στα ζώα 

ηλικίας 2 μηνών που εκτέθηκαν στην αιθανόλη σε σχέση με τα αντίστοιχα ζώα 

ελέγχου. Σχετικά με τον αριθμό των κυττάρων η προγεννητική έκθεση στην 

αιθανόλη μείωσε σημαντικά τον συνολικό αριθμό των κυττάρων του ραχιαίου 

ραβδωτού σώματος στα ζώα 2 μηνών που εκτέθηκαν στην αιθανόλη σε σχέση με τα 

αντίστοιχα φυσιολογικά ενώ σημαντική διαφορά δεν υπήρχε στα ζώα 3,5 μηνών 

που εκτέθηκαν σε σχέση με τα αντίστοιχα ζώα ελέγχου. Ο αριθμός των νευρικών 

κυττάρων μειώθηκε σημαντικά στα ζώα 2 μηνών που εκτέθηκαν στην αιθανόλη ενώ 

διαφορά δεν παρατηρήθηκε στα ζώα 3,5 μηνών που εκτέθηκαν πάντα σε σύγκριση 

με τα αντίστοιχα φυσιολογικά. Τέλος, σημαντική διαφορά στον αριθμό των μη 

νευρικών κυττάρων δεν παρατηρήθηκε στα ζώα ηλικίας 2 μηνών και στα ζώα 

ηλικίας 3,5 μηνών.  
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Σύμφωνα με μελέτες, η αιθανόλη πράγματι φαίνεται να επηρεάζει την περιοχή του 

ραχιαίου ραβδωτού σώματος όπως φάνηκε και από τα αποτελέσματα μας. 

Μεταβολές στο σχήμα του ραβδωτού σώματος σε απογόνους θηλικών ποντικών 

C57BL/6J μετά από ενδοπεριτονιακή χορήγηση δύο δόσεων με διαφορά 4 ωρών 

2,8gr/kg αιθανόλης την προγεννητική μέρα 8 στις μητέρες τους [27] όπως και 

μεταβολή στις διασυνδέσεις των νευρώνων της περιοχής αυτής σε απογόνους Ai14 

ποντικών όπου η μητέρες αρχικά εκτέθηκαν σε διάλυμα 20% αιθανόλης πριν την 

εγκυμοσύνη μέρα παρά μέρα για 6 εβδομάδες και με την έναρξη της εγκυμοσύνης 

σε διάλυμα 10% αιθανόλης που συνεχίστηκε μέχρι τη μεταγεννητική μέρα 10 [28] 

φαίνεται να προκαλούνται από την προγεννητική έκθεση στην αιθανόλη. Ακόμα σε 

επίμυες τύπου Sprague Dawley, που είναι και ο τύπος που χρησιμοποιήθηκε στην 

παρούσα εργασία, η προγεννητική έκθεση στην αιθανόλη προκάλεσε αλλαγές στις 

διαδικασίες LTP και LTD σε νευρώνες του ραχιαίου ραβδωτού σώματος 

μεταβάλλοντας την λειτουργία των υποδοχέων ντοπαμίνης. [29] 

Επικλινής πυρήνας (nucleus accumbens) 

Η περιοχή του κοιλιακού ραβδωτού σώματος (επικλινής πυρήνας) φαίνεται επίσης 

να επηρεάζεται από την ηλικία. Με εξέταση ξεχωριστά του κεντρικού τμήματος 

(πυρήνας) και του κελύφους του επικλινούς πυρήνα φάνηκε ότι και στις δύο 

περιοχές υπήρχε στατιστικώς σημαντική μείωση στην ένταση σήματος των 

σωματιδίων Nissl στα ζώα ελέγχου ηλικίας 3,5 μηνών σε σχέση με τα ζώα ελέγχου 

ηλικίας 2 μηνών. Από όσο γνωρίζουμε, δεν υπάρχουν βιβλιογραφικά δεδομένα 

σχετικά με την ωρίμανση του επικλινούς πυρήνα μεταξύ εφηβείας (~2Μ) και 

ενήλικης ζωής (>3Μ) στους επίμυες. Η συγκεκριμένη μελέτη αποτελεί μια πρώτη 

προσπάθεια καταγραφής γεγονότων. 

Η προγεννητική έκθεση των ζώων στην αιθανόλη δεν φάνηκε να έχει κάποια 

επίδραση στο κεντρικό τμήμα του επικλινούς πυρήνα καθώς δεν υπήρχε σημαντική 

διαφορά στην ένταση σήματος των σωματιδίων Nissl ανάμεσα στα ζώα που 

εκτέθηκαν στην αιθανόλη ηλικίας 2 μηνών σε σχέση με τα αντίστοιχα φυσιολογικά 

ούτε ανάμεσα στα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν στην αιθανόλη σε σχέση 

με τα αντίστοιχα φυσιολογικά. Σχετικά με το κέλυφος του επικλινούς πυρήνα ενώ η 

προγεννητική έκθεση στην αιθανόλη δεν προκάλεσε σημαντική αλλαγή ανάμεσα 



- 79 - 
 

στα ζώα 2 μηνών που εκτέθηκαν σε σχέση με τα αντίστοιχα ζώα ελέγχου, 

παρατηρήθηκε στατιστικώς σημαντική αύξηση στην ένταση σήματος των 

σωματιδίων Nissl στα ζώα ηλικίας 3,5 μηνών που εκτέθηκαν στην αιθανόλη σε 

σχέση με τα αντίστοιχα φυσιολογικά. 

Αυτά τα αποτελέσματα συμβαδίζουν με μελέτες οι οποίες δεν έδειξαν κάποια 

σημαντική επίπτωση της αιθανόλης στην περιοχή του κεντρικού τμήματος και του 

κελύφους του επικλινούς πυρήνα σχετικά με τον αριθμό των νευρώνων, καθώς και 

και τη μορφολογία και πυκνότητα των δενδριτών, σε ζώα που εκτέθηκαν 

προγεννητικά στην αιθανόλη σε σχέση με ζώα ελέγχου [8]. Η ίδια μελέτη έδειξε ότι 

η αιθανόλη προκάλει αύξηση στον αριθμό των συνάψεων μεταξύ δενδριτών σε 

θηλυκούς επίμυες Long Evans που εκτέθηκαν στην αιθανόλη, κάτι που 

επιβεβαιώνεται από άλλες μελέτες που έδειξαν ότι η αιθανόλη προκαλεί μεταβολές 

στις προεκβολές των δενδριτών στην περιοχή του επικλινούς πυρήνα [29]. Έχει 

διαπιστωθεί επίσης ότι υπάρχει η δυνατότητα αύξησης της νευρογένεσης των 

μέσων ακανθωδών νευρώνων (MSNs) στην περιοχή του επικλινούς πυρήνα σε 

ποντίκια σε μοντέλο πόνου [37]. Με βάση τα παραπάνω, μπορεί να δικαιολογηθεί η 

αύξηση της έντασης σήματος των σωματιδίων Nissl στην περιοχή του κελύφους του 

επικλινούς πυρήνα στα ζώα 3,5 μηνών που εκτέθηκαν στην αιθανόλη καθώς η 

αιθανόλη μπορεί να προκαλέσει μεταβολές στους δενδρίτες και ίσως και 

νευρογένεση στον επικλινή πυρήνα. Βέβαια η αιθανόλη δεν προκαλεί άμεσα πόνο  

είναι όμως, όπως ο πόνος, στρεσογόνο ερέθισμα [38].  Είναι γνωστό ότι, οι ορμόνες 

του στρες που απελευθερώνονται στο ΚΝΣ μετά από έκθεση σε αναπόφευκτα, 

απεχθή ερεθίσματα μεταβάλλουν τη φυσιολογία των νευρώνων σε πολλαπλές 

περιοχές του εγκεφάλου, συμπεριλαμβανομένου του ιππόκαμπου, της αμυγδαλής, 

του προμετωπιαίου φλοιού και της κοιλιακής καλυπτρικής περιοχής. Ο επικλινής 

πυρήνας, ο οποίους ως γνωστό συνδέεται με τα κίνητρο και την ανταμοιβή, 

λαμβάνει εισόδους από καθεμία από αυτές τις περιοχές του εγκεφάλου που 

επηρεάζονται από το στρες, γεγονός που αυξάνει την πιθανότητα η λειτουργία του 

και ιδιαίτερα αυτή του κέλυφος [38] να μεταβάλλεται ως απάντηση στο στρες.  
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Κεντρικός πυρήνας αμυγδαλή 

Η περιοχή του κεντρικού πυρήνα της αμυγδαλής φαίνεται να επηρεάζεται από την 

ηλικία καθώς η ένταση σήματος των σωματιδίων Nissl ήταν στατιστικώς σημαντικά 

μειωμένη στα ζώα ελέγχου ηλικίας 3,5 μηνών σε σχέση με τα ζώα ελέγχου ηλικίας 2 

μηνών. Το γεγονός ότι η συνδεσιμότητα της αμυγδαλής στον άνθρωπο επηρεάζεται 

με την αύξηση της ηλικίας είναι γνωστό [3939, σύγκριση ατόμων μέσης ηλικίας 24.8 

και 70.23 χρόνων] όπως επίσης είναι γνωστό ότι η αύξηση της ηλικίας οδηγεί σε 

μείωση της μνήμης αρνητικών ερεθισμάτων [39]. Σε ότι αφορά τους επίμυες, αλλά 

και τον άνθρωπο δεν υπάρχουν μελέτες αντίστοιχες με τη δική μας που να αφορούν 

σύγκριση μεταξύ της εφηβικής και νεαρής ενήλικης ηλικίας.  

Η προγεννητική έκθεση στην αιθανόλη είχε ως συνέπεια την μείωση στην ένταση 

σήματος των σωματιδίων Nissl στα ζώα 2 μηνών που εκτέθηκαν στην αιθανόλη σε 

σχέση με τα αντίστοιχα φυσιολογικά ενώ σημαντική διαφορά δεν παρατηρήθηκε 

ανάμεσα στα ζώα 3,5 μηνών που εκτέθηκαν στην αιθανόλη σε σχέση με τα 

φυσιολογικά. Η έκθεση στην αιθανόλη τις πρώτες μεταγεννητικές μέρες έχει δειχθεί 

ότι προκαλεί εκφυλισμό σε νευρώνες, κάτι που μπορεί να δικαιολογήσει την μείωση 

στην ένταση των σωματιδίων Nissl που παρατηρήθηκε στα ζώα ηλικίας 2 μηνών που 

εκτέθηκαν στην αιθανόλη [9]. Σύμφωνα με την μελέτη αυτή παρατηρήθηκε επίσης 

αύξηση στην έκφραση των κασπασών 3 και 9 τις πρώτες μέρες μετά τη γέννηση 

επιβεβαιώνοντας τον κυτταρικό θάνατο που προκάλεσε η αιθανόλη στα νευρικά 

κύτταρα μέσω απόπτωσης. 

Μεσολόβιο 

Ως γνωστόν το πάχος του μεσολοβίου στο επίπεδο του ιπποκάμπου δεν είναι 

σταθερό σε όλη του την έκταση και αυτό επιβεβαιώθηκε καθώς το πάχος στην 

περιοχή από Βρέγμα -2,16 μέχρι -2,92 και στην περιοχή από Βρέγμα -3,00 μέχρι -

3,72 [40]  φάνηκε στατιστικώς σημαντικά διαφορετικό στα ζώα ελέγχου ηλικίας 2 

μηνών. Η περιοχή του μεσολοβίου στο επίπεδο του ιπποκάμπου δεν φάνηκε να 

επηρεάζεται από το πρωτόκολλο έκθεσης που χρησιμοποιήθηκε στον συγκεκριμένο 

τύπο επίμυων. Η μελέτη του πάχους του μεσολοβίου στην περιοχή που εξετάστηκε 

από Βρέγμα -2,16 μέχρι Βρέγμα -2,92 σύμφωνα με τον άτλαντα των Paxinos & 

Watson [4040] δεν έδειξε κάποια σημαντική διαφορά στα ζώα ηλικίας 2 μηνών που 
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εκτέθηκαν στην αιθανόλη σε σχέση με τα ζώα ελέγχου ούτε ανάμεσα στα ζώα 

ηλικίας 3,5 μηνών που εκτέθηκαν σε σχέση με τα αντίστοιχα ζώα ελέγχου. 

Τα αποτελέσματα αυτά έρχονται σε αντίθεση με μελέτες που υποστηρίζουν ότι το 

μεσολόβιο είναι από τις περιοχές που έχουν την μεγαλύτερη επίπτωση από την 

προγεννητική έκθεση στην αιθανόλη και προκαλούν σε αυτό δυσμορφίες και 

μείωση στο πάχους του [10, 12]. Βέβαια υπάρχουν και μελέτες που, μέσω 

μαγνητικής τομογραφίας, δεν έδειξαν αλλαγή στο μεσολόβιο παιδιών που 

εκτέθηκαν προγεννητικά σε αιθανόλη εκτός από μία μείωση στο μέσον του 

μεσολοβίου όταν αυτό εξετάστηκε ξεχωριστά [11]. Τέλος, σε μία μελέτη σε επίμυες 

τύπου Sprague Dawley φάνηκε ότι η προγεννητική έκθεση στην αιθανόλη στα 

αρχικά στάδια της κύησης είχε επίδραση σε νευρώνες που ξεκινούν από το 

μεσολόβιο και καταλήγουν στον οπτικό φλοιό [13, 14].  

 

Η παρούσα εργασία είχε σκοπό να αναδείξει την μακροχρόνια επίπτωση της 

προγεννητικής έκθεσης στην αιθανόλη σε διάφορες εγκεφαλικές περιοχές επίμυων 

Sprague Dawley εφηβικής και νεαρής ενήλικής ηλικίας με απώτερο στόχο την 

καλύτερη κατανόηση των επιπτώσεων της προγεννητικής έκθεσης στην αιθανόλη 

στον εγκέφαλο καθώς αποτελεί ένα φαινόμενο που τείνει να αυξηθεί τα επόμενα 

χρόνια  [1]. Περαιτέρω μελέτες είναι απαραίτητο να διεξαχθούν για την πλήρη 

διαλεύκανση των μηχανισμών με τους οποίους η έκθεση στην αιθανόλη κατά την 

διάρκεια της εγκυμοσύνης έχει δυσμενείς επιπτώσεις στο έμβρυο με επίκεντρο τον 

άνθρωπο. 
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